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1. Description

The Plexor® HY System(a–f) is a novel real-time PCR system for quantification of total human (autosomal) and human 
male (Y) DNA within a sample. This Technical Manual describes the Plexor® HY System and provides instructions for 
use with the Applied Biosystems 7500 and 7500 FAST Real-Time PCR Systems, including reaction setup, real-time 
PCR instrument programming and data analysis using the Plexor® Analysis Software.

The Plexor® technology takes advantage of the specific interaction between two modified nucleotides to achieve 
quantitative PCR analysis (1–3). One of the PCR primers contains a modified nucleotide (iso-dC) linked to a 
fluorescent label at the 5´ end. The second PCR primer is unlabeled. The reaction mix includes deoxynucleotides and 
iso-dGTP modified with the quencher dabcyl. Dabcyl-iso-dGTP is incorporated opposite the iso-dC residue in the 
primer. The incorporation of the dabcyl-iso-dGTP at this position results in quenching of the fluorescent dye on the 
complementary strand and a reduction in fluorescence, which allows quantification during amplification (Figure 1).

With the Plexor® technology, accumulation of product is accompanied by a decrease in fluorescence as shown in  
Figure 2.

The Plexor® technology allows the use of a melt curve or dissociation curve to determine the melting temperature (Tm) 
of the products following amplification (Figure 3). This is useful in assessing the specificity of the reaction.
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Figure 1. Schematic diagram illustrating the Plexor® real-time PCR process.
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Figure 2. Representative Plexor® amplification curves. The amplification curves show the fluorescence (in 
relative fluorescence units, RFU) at each cycle of the reaction. The amplification threshold is indicated by a horizontal 
line across the graph. This line is used to determine the quantification cycle (Cq) for the samples.
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1. Description (continued)
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Figure 3. Representative Plexor® melt curves. Melting temperature is empirically determined by plotting the 
change in fluorescence with temperature (–dRFU)/dT versus temperature and determining the temperature at which 
the greatest rate of change in fluorescence occurs.

The fluorescein dye of the Plexor® HY System is used to detect a human autosomal DNA target. The primers amplify a 
multicopy, 99bp target on chromosome 17. Data from this reaction are used to quantify the total amount of human 
DNA in a sample.

The CAL Fluor® Orange 560 dye of the Plexor® HY System is used to detect a Y-chromosomal DNA target. The primers 
amplify a multicopy 133bp target on the Y chromosome. Data from this reaction are used to quantify the total amount 
of human male DNA in a sample.

The CAL Fluor® Red 610 dye of the Plexor® HY System is used to detect the Internal PCR Control (IPC), which is 
added to every reaction. The primers amplify a novel DNA sequence added as a template to the reaction mix. The 
amplified product is 150 base pairs. Data from this target are used to monitor inhibition of amplification in samples.

The IC5 dye of the Plexor® HY System is used as a passive reference. IC5-labeled reagent is included in the Plexor® HY 
20X Primer/IPC Mix. Data from the three amplification channels (fluorescein, CAL Fluor® Orange 560 and CAL Fluor® 

Red 610) can be normalized to this signal.

The Plexor® HY System uses a hot-start chemistry. Reaction setup can be performed at room temperature and is 
amenable to automation.
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2. Product Components and Storage Conditions

P R O D U C T  S I Z E  C AT. #

Plexor® HY System 200 reactions DC1001

Not for Medical Diagnostic Use. Includes:

• 2 × 1ml Plexor® HY 2X Master Mix
• 200µl Plexor® HY 20X Primer/IPC Mix
• 150µl Plexor® HY Male Genomic DNA Standard, 50ng/µl
• 2 × 1.25ml Water, Amplification Grade

P R O D U C T  S I Z E  C AT. #

Plexor® HY System 800 reactions DC1000

Not for Medical Diagnostic Use. Includes:

• 8 × 1ml Plexor® HY 2X Master Mix
• 4 × 200µl Plexor® HY 20X Primer/IPC Mix
• 3 × 150µl Plexor® HY Male Genomic DNA Standard, 50ng/µl
• 5 × 1.25ml Water, Amplification Grade

Storage Conditions: Store the Plexor® HY System at –30°C to–10°C in a nonfrost-free freezer. Once thawed, store  
the Plexor® HY Male Genomic DNA Standard at 2–10°C; do not refreeze. For short-term storage, less than 1 week,  
the other components of the system can be stored at 2–10°C. Minimize the number of freeze-thaw cycles.

Item Available Separately

P R O D U C T   C AT. #

Plexor® Calibration Kit, Set A  DC1500

Not for Medical Diagnostic Use. Includes:

• 50µl Plexor® Concentrated Fluorescein Calibrator
• 50µl Plexor® Concentrated CAL Fluor® Orange 560 Calibrator
• 50µl Plexor® Concentrated CAL Fluor® Red 610 Calibrator
• 50µl Plexor® Concentrated IC5 Calibrator
• 11ml Plexor® 1X Calibration Buffer
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3. General Considerations

The key to the Plexor® technology is the quenching of a fluorescent reporter due to the site-specific incorporation of 
dabcyl-iso-dGTP. As a result, the fluorescent signal from a Plexor® HY reaction decreases as PCR product accumulates. 
Real-time instrument software can record the quenching data, but most cannot determine quantification cycle or 
melting temperatures. Data analysis is accomplished by exporting the data to the Plexor® Analysis Software. The 
Plexor® Analysis Software is compatible with data from all supported instruments. The software is compatible with 
Windows® 98 and later operating systems.

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor® Analysis Software. All 
instructions in this Technical Manual refer to the forensic release of the software. The Plexor® Analysis Software and 
instructions for software installation can be downloaded free of charge from the Promega Web site at:  
www.promega.com/plexorhy/

We recommend using designated work areas and pipettes for pre- and post-amplification steps to minimize the 
potential for cross-contamination between samples and prevent carryover of nucleic acid from one run to the next. 
Wear gloves, and change them often. Prevent contamination by using aerosol-resistant pipette tips. Always include a 
no-template control (NTC) reaction to detect contamination. We recommend performing NTC reactions in duplicate.

!  Do not unseal reaction plates after amplification is complete. Unsealing the plates increases the risk of 
contaminating subsequent reactions with amplified product.

 Caution: We highly recommend the use of gloves and aerosol-resistant pipette tips.

4. Instructions for HID Real-Time PCR Analysis Software and SDS Software, Version 2.0 and Higher

4.A. Calibration Protocol for HID Real-Time PCR Analysis Software and SDS Software, Version 2.0 and 
Higher

Before using the Plexor® HY System, the instrument must be calibrated for fluorescein, CAL Fluor® Orange 560,  
CAL Fluor® Red 610 and IC5. The Plexor® Calibration Kit, Set A, includes aliquots of these four calibrators at a 100X 
concentration, along with a calibration buffer for use as a diluent to create a spectral calibration plate for each dye.  
See Section 8.J for example spectral calibration results.

Before performing the dye calibration, we recommend performing a background calibration. Follow the guidelines in 
the instrument manual to perform a background calibration using the background plate provided by the instrument 
manufacturer.

Materials to Be Supplied By the User

• Plexor® Calibration Kit, Set A (Cat.# DC1500)

• background plate provided with the 7500 or 7500 Fast Real-Time PCR Systems Spectral Calibration Kit I 
(Applied Biosystems)

• real-time PCR instrument and related consumables (i.e., PCR plates and plate covers)

!
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Calibration Plate Setup

1. Thaw the four concentrated calibrators (fluorescein, CAL Fluor® Orange 560, CAL Fluor® Red 610 and IC5) and 
Plexor® 1X Calibration Buffer.

2. Vortex the concentrated calibrators and Plexor® 1X Calibration Buffer to mix for 10 seconds. Do not centrifuge 
the spectral calibrators after vortexing.

3. For each spectral calibrator, dilute each individual spectral calibrator 1:100 in Plexor® 1X Calibration Buffer, as 
described in Table 1.

Table 1. Preparation of Calibrators for Calibration Plate.

Component Fluorescein
CAL Fluor® 
Orange 560

CAL Fluor®  
Red 610 IC5

Concentrated 
Calibrator

 
22µl

 
22µl

 
22µl

 
22µl

Plexor® 1X 
Calibration Buffer

 
2178µl

 
2178µl

 
2178µl

 
2178µl

4. Vortex the diluted spectral calibrators for 10 seconds to mix. Do not centrifuge the spectral calibrators after 
vortexing.

5. For each diluted spectral calibrator, dispense 20µl to all 96 wells of a 96-well optical plate. Record the bar code 
number or mark the side of the plate skirt to designate the fluorescein, CAL Fluor® Orange 560, CAL Fluor® Red 
610 and IC5 spectral calibration plates.

6. Apply the appropriate plate seal to each plate. Protect plates from light.

7. Centrifuge plates briefly.

 Notes:

1. These instructions pertain to the calibration process using the HID software or SDS software, version 2.0 and 
higher. When required, define fluorescein as “FL”, CAL Fluor® Orange as “CO560”, CAL Fluor® Red as 
“CR610” and IC5 as “IC5”. These designations will be used during instrument programming, data import 
into the Plexor® Analysis Software and final reporting.

2. Each plate calibration takes ~10 minutes. After calibration, store the calibration plate, protected from 
light, at –20°C. Reuse the plate when reanalysis is necessary. Calibration plates can be stored for up to a 
year and should not be reused more than four times.

Instrument Calibration

1. Open the HID software or SDS software.

2. In the Launch Window of the HID software, click the “Custom Assays” button of the HID software. For SDS 
software, version 2.0 and higher, proceed to Step 3.

3. Select “Instrument” in the menu bar and then “Instrument Maintenance Manager”.
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4.A. Calibration Protocol for HID Real-Time PCR Analysis Software and SDS Software, Version 2.0 and 
Higher (continued)

4. Select the “Dye” section tab from the left sidebar.

5. In the Dye Screen select “Custom Dye Calibration” and click “Start Calibration” (Figure 4).
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Figure 4. Select Custom Dye Calibration and Start Calibration.

6. In the “Create new custom dye calibration?” dialog box that appears, select “yes.”

7. In the “Custom Dye Calibration Setup” window that follows, select the “New Dye” button (Figure 5).
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Figure 5. Calibrating a new dye.



Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · 608-274-4330 · Fax 608-277-2516 9
www.promega.com  TM293 · Revised 9/17

8. In the “Dye Library” dialog box that appears select the “New” button (Figure 6).
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Figure 6. Select “New” in the Dye Library dialog box.

9. Enter “FL” as the new dye Name, select the “Reporter” radio button under “Type” then select “OK” (Figure 7).
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Figure 7. Naming the new dye.

10. Repeat for CO560, CR610 and IC5.

11. In the Custom Dye Calibration Setup window select “FL” from the Dye Name drop-down list in Step 2 (Figure 8).
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Figure 8. Select the dye name from the drop-down list.
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4.A. Calibration Protocol for HID Real-Time PCR Analysis Software and SDS Software, Version 2.0 and 
Higher (continued)

12. Load the plate with the FL calibration dye into the instrument.

13. Check “The custom dye plate is loaded into the instrument”.

14. Select “Start Run” (Figure 9).
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Figure 9. Start run.

15. Once the calibration run is completed, select “Next” in the bottom right of the window (Figure 10). The software 
will display the spectra and indicate whether the spectra is acceptable (passed) under Status.
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Figure 10. Acceptable spectra display. The expected dye spectra are shown in Section 8.J, Figure 60.

16. Click “Finish”, and repeat the calibration for CO560, CR610 and IC5.
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4.B. Reaction Plate Setup

When using the Plexor® HY System for the first time, we recommend programming the instrument (Section 4.C) before 
assembling the reactions. Once you are familiar with the programming process, the instrument can be programmed 
after reaction setup.

Materials to Be Supplied By the User
(Solution compositions are provided in Section 8.M.)

• sterile, aerosol-resistant pipette tips

• pipettes dedicated to pre-amplification work

• real-time PCR instrument and related consumables, such as the appropriate PCR plate and plate covers

• TE–4 buffer

• Plexor® Analysis Software (forensic release)

Template Preparation

Change gloves often, especially after handling high-concentration DNA. These instructions use 2µl of template DNA 
per reaction. The sample volume can be increased as long as the final reaction volume stays constant. Sample volumes 
and final reaction volumes must be the same for both the DNA standards and the unknown samples, allowing the DNA 
standards to be considered as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume). The standard 
curve described below uses DNA standards in the range of 3.2pg/µl to 50ng/µl. These values can be modified if 
desired. See Section 8.B.

Sample DNA Templates (Unknowns)

Use 2µl of sample DNA per reaction. Performing duplicate analysis of each sample DNA and averaging the 
quantification results can reduce variability. The sample DNA can be diluted in TE–4 buffer, if desired.

DNA Standards

The Plexor® HY System is supplied with the Plexor® HY Male Genomic DNA Standard, 50ng/µl. This DNA is a mixture 
of human male DNA. Use of other DNA (e.g., DNA isolated from a cell line) as a standard is not recommended.

Serial dilutions of the DNA standard are amplified in the same plate as the unknown samples, and the results are used 
to generate a standard curve in the autosomal (fluorescein) and Y (CAL Fluor® Orange 560) channels to determine the 
concentrations of unknown samples. We recommend performing duplicate or triplicate amplification reactions with 
each dilution of the DNA standard. Use of a dedicated set of pipettes can increase run-to-run consistency. Use the same 
pipettes to dispense the DNA standards and unknown samples.

!  Multiple freeze-thaw cycles of the Plexor® HY Male Genomic DNA Standard, 50ng/µl, can increase variability in 
the standard curve. High-molecular-weight DNA may form aggregates or concentration gradients when frozen, 
which may result in sampling error. Store the DNA standard at 4°C overnight before using it for the first time 
and vortex prior to use. We recommend long-term storage at 2–10°C.
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4.B. Reaction Plate Setup (continued)

1. Thaw and vortex the Plexor® HY Male Genomic DNA Standard, 50ng/µl, at high speed for 10 seconds. After 
initial thawing, store at 2–10°C.

2. Prepare fresh serial dilutions of the Plexor® HY Genomic DNA Standard as indicated in Table 2. Vortex each 
dilution for 10 seconds before removing an aliquot for the next dilution. Be sure to change pipette tips between 
dilutions. Change gloves after handling high-concentration DNA.

Table 2. Serial Dilution of the Plexor® HY Genomic DNA Standard.

Concentration Volume of DNA Volume of TE–4 Buffer

50ng/µl Use undiluted DNA 0µl

10ng/µl 10µl of undiluted DNA 40µl

2ng/µl 10µl of 10ng/µl dilution 40µl

0.4ng/µl 10µl of 2ng/µl dilution 40µl

0.08ng/µl 10µl of 0.4ng/µl dilution 40µl

0.016ng/µl 10µl of 0.08ng/µl dilution 40µl

0.0032ng/µl 10µl of 0.016ng/µl dilution 40µl

Note: We do not recommend storing diluted standards. 

No-Template Control

Include a no-template control (NTC) reaction for each set of reactions. Add 2µl of TE–4 buffer to these reactions in 
place of the template DNA. There should be no amplification product (i.e., <1.0pg/µl with a 2µl input volume) detected 
in the NTC reaction. Amplification of >1.0pg/µl of DNA in the NTC reaction indicates nonspecific amplification or the 
presence of contaminating DNA.

Note: The Plexor® HY System is extremely sensitive. The NTC reaction may show amplification products in the 
subpicogram range.

Reaction Setup

1. Thaw the Plexor® HY 2X Master Mix, Plexor® HY 20X Primer/IPC Mix and Water, Amplification Grade.

 Note: Do not thaw the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix at temperatures above 
room temperature.

2. Vortex the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix for 10 seconds to mix. Do not 
centrifuge after vortexing, as this may cause the primers to be concentrated at the bottom of the tube.

3. Determine the number of reactions to be set up. This should include negative control reactions. Increase this 
number by 10–15% to compensate for pipetting error. While this approach does require using a small amount 
of extra reagent, it ensures that you will have enough PCR master mix for all samples. It is critical that the same 
reaction mix is used for the entire run.
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4. Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY 2X Master Mix and Plexor® 
HY 20X Primer/IPC Mix as indicated in Table 3. The reaction mix will be used to perform the NTC reaction and 
amplify samples and DNA standards. To amplify a larger input template volume, see Section 8.B.

Table 3. Preparation of Reaction Mix for Quantification Assays (assumes 2µl of template per reaction).

Component Volume (Per Reaction)

Plexor® HY 2X Master Mix 10µl

Water, Amplification Grade 7µl

Plexor® HY 20X Primer/IPC Mix 1µl

final volume 18µl

5. Vortex for 10 seconds to mix. Do not centrifuge after vortexing.

6. Add 18µl of the reaction mix prepared in Step 4 to each of the appropriate wells of an optical-grade PCR plate.

7. Add 2µl of TE–4 buffer to the NTC reactions (Figure 11).

8. Add 2µl of DNA standard or unknown sample to the reaction mix in the appropriate wells (Figure 11). Duplicate 
amplification of standards is required. Duplicate analysis of unknown samples and subsequent averaging of the 
DNA concentration will reduce the impact of variability due to pipetting, sampling or amplification.

9. Seal the plates with manufacturer-approved optical caps or optical adhesive cover using the applicator.

10. Centrifuge the plate briefly to collect the contents of the wells at the bottom. The plate is ready for thermal 
cycling. Protect the plate from extended light exposure or elevated temperatures before cycling. Handle the plate 
by the edges, and avoid touching the bottom of the plate.
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Figure 11. Schematic diagram showing distribution of the diluted DNA standard and unknown samples 
(UNK) in a 96-well PCR plate.
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4.C. Instrument Setup and Thermal Cycling for HID Real-Time PCR Analysis Software and SDS Software, 
Version 2.0 and Higher

The instructions given here are for Applied Biosystems 7500 instruments using the HID software or SDS software, 
version 2.0 and higher. For instructions using SDS software, version 1.4, see Section 5.C.

General Setup

1. Open the HID software or SDS software, version 2.0 and higher.

2. For HID software, select the “Custom Assays” button. For SDS software, proceed to Step 3.

3. From the Setup menu (or New Experiment pull-down) choose “Advanced Setup”.

4. In the “Experiment Properties” form (Figure 12), specify the following parameters:

Experiment Name: user choice

Which Instrument: 7500 (96 Wells)

What type of experiment: Quantitation – Standard Curve

Which reagents: Other

 • Check “Include Melt Curve”

Which ramp speed: Standard (~2 hours to complete a run)

11
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Figure 12. Advanced Setup screen.
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5. Select “Plate Setup” from “Setup” menu in left sidebar. Select “Define Targets & Samples” tab (Figure 13). Click 
four times on “Add new Target”, and enter the following:

Targets: AUTO (Reporter = FL), Y (Reporter = CO560), IPC (Reporter = CR610), Pass Ref (Reporter = IC5)

For all dyes, Quencher = “none”

 Note: The Plexor® HY passive reference dye is included as a target rather than specified as a passive reference; 
passive reference normalization is performed in the Plexor® Analysis Software.

11
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Figure 13. Plate Setup screen.

6. Select “Assign Targets and Samples” tab (Figure 14), and highlight the wells in use on the plate map. Assign all 
four targets to the selected wells. Do not highlight unused wells. Select “None” for passive reference.

 Note: Sample names may be defined in HID software or SDS software, version 2.0 and higher, and exported 
with the data into the Plexor® Analysis Software.
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Figure 14. Assign Targets and Samples tab.
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4.C. Instrument Setup and Thermal Cycling for HID Real-Time PCR Analysis Software and SDS Software, 
Version 2.0 and Higher (continued)

7. Confirm “None” is selected for the passive reference.

8. Select “Run Method” from the left sidebar; modify the default Run Method as directed below (the completed 
Plexor® Run Method is shown in Figure 15):

Reaction Volume: 20µl

Delete the first Holding stage

Modify the second Holding stage to 2 minutes at 95°C

Cycling Stage: 38 cycles of 5 seconds at 95°C, then 35 seconds at 60°C

Melt Cycle Stage: Delete the final step (hold at 60°C); leave the remainder at default settings

 Note: The instrument setup and thermal cycling program (Table 4) can be saved as a template for future use. To 
do so, choose “File”, then “Save As”. Select “SDS Template” as the file type, then save the file. This template can 
be opened by selecting “File”, then “Open” and used for future assays.

Table 4. Thermal Cycling Program.

Step Temperature Time Number of Cycles

Initial denaturation: 95°C 2 minutes 1 cycle

Denaturation:

Annealing and extension:

95°C

60°C

5 seconds

35 seconds
38 cycles

Melt temperature curve: Use the default “Dissociation Function” settings.

9. If ready to run a plate, save the experiment document (.eds file).

10. Place the PCR plate into the instrument, and immediately press “Start Run”.

 Prolonged exposure of the reactions to high temperatures or light before thermal cycling might adversely affect 
the final results.!
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Figure 15. Complete Plexor® HY run method.
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4.D. Data Export from HID Real-Time PCR Analysis Software and SDS Software, Version 2.0 and Higher

1. In the real-time PCR analysis software, select “Export” from the top toolbar (Figure 16).
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Figure 16. Export the results.

2. In the “Export Data” window (Figure 17), select the following “Export Properties”:

• Select the data to export: “Multicomponent Data”.

• If Sample Names were defined in the real-time PCR analysis software, these can be exported by also  
selecting “Sample Setup”.

• File Type: Select .xls.

• Specify the appropriate export file name and file location.

• Select “Start Export”.

Notes:

1. These settings can be saved as the default; click the checkbox in the lower left corner of this screen.

2. If the data will be analyzed on a separate computer, save the files on removable storage media or an accessible 
network location for data transfer. These files are now ready for use with the Plexor® Analysis Software.
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Figure 17. Export properties.
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4.E. Data Import into the Plexor® Analysis Software from HID Real-Time PCR Analysis Software and 
SDS Software, Version 2.0 and Higher

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor® Analysis Software. The 
Plexor® Analysis Software and instructions for software installation can be downloaded free of charge from the 
Promega Web site at: www.promega.com/plexorhy/

1. To launch the Plexor® Analysis Software, go to the “Start” menu and select “Plexor Analysis Software - 
Forensics” and then “Plexor Analysis Software - Forensics.exe”.

 Notes:

1. A shortcut can be placed on the desktop by right-clicking on the Analysis Desktop, selecting “Copy” and 
then right-clicking on the Windows® desktop and selecting “Paste Shortcut”.

2. A master template for routine settings for import and analysis can be created. See Section 8.H for details 
concerning this option.

2. In the File menu, select “Set Passive Reference On Import”. With HID software or SDS software, version 2.0  
and higher, the IC5 passive reference data is imported separately, and the normalization is applied within 
Plexor® Analysis Software.

3. In the File menu, select “Import New Run” or select the icon. 

 Optional: Enter an assay name in the Assay Setup screen, Step 1 (Figure 18). This screen is used to enter  
information about the type and format of data that will be used for each assay.
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Figure 18. Step 1 – Assay Setup screen. Specify instrument and targets or dyes.
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4.E. Data Import into the Plexor® Analysis Software from HID Real-Time PCR Analysis Software and 
SDS Software, Version 2.0 and Higher (continued)

4. Select the correct instrument type and software version you are using.

5. Select “Add Target” four times.

6. For each dye assign a target name and the correct dye: Autosomal (FL), Y (CO560), IPC (CR610),  
Passive Reference (IC5).

• For AUTO, Y and IPC, select “Amp” and “Melt” boxes.

• For Pass Ref select the “Pass. Ref.” box.

 Note: The name of the dye must be the same as that in the data file (Section 4.C). You can select "Export", and 
save the assay setup as an Assay Template file (.atp) for subsequent analysis. See Section 8.H for more details.

7. Select “Next”.

8. Enter information specific to your run in the Run Info screen, Step 2 (Figure 19). Details such as the date, notes, 
title, etc., also can be entered. These fields are optional.
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Figure 19. Step 2 – Run Info screen. Enter run-specific information.

9. Select “Next”.
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10. In Step 3, use the File Import screen (Figure 20) to specify the appropriate data file.

11. Enter the number of amplification cycles (38), and the range of melt temperatures (60 to 95 for the default 
dissociation profile).

 Note: You can select “Advanced Options” to apply templates that specify routine setup and analysis parameters. 
See Section 8.H for details concerning these advanced options.
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Figure 20. File Import. Specify the data file to be imported and run parameters. Templates also may be applied.
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4.E. Data Import into the Plexor® Analysis Software from HID Real-Time PCR Analysis Software and 
SDS Software, Version 2.0 and Higher (continued)

12. Select “Finish” to complete the data import and open the Analysis Desktop.

 Note: If the names of the dyes you have entered do not match those listed in the data files, an error message will 
appear (Figure 21). This message will appear if you have: 

a. not properly defined dye(s) during calibration (i.e., named Plexor® Concentrated Fluorescein Calibrator as 
FAM rather than FL),

b. incorrectly named the detector(s) during new detector creation or 

c. selected the wrong detector(s) in the New Document Wizard.

 If this message appears, return to the Assay Setup screen, Step 1 (Figure 18). Click on the Dye field under the Data 
Collection heading, and enter the dye names exactly as shown in the error message after “Found:”. Any dye name 
entered must exist in the data file. Only those dyes entered will be analyzed. Repeat Steps 6–12 of this protocol.
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Figure 21. The Dye Mismatch error message.
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5. Instructions for SDS Software, Version 1.4

5.A. Calibration Protocol for SDS Software, Version 1.4

Before using the Plexor® HY System, the instrument must be calibrated for fluorescein, CAL Fluor® Orange 560,  
CAL Fluor® Red 610 and IC5. The Plexor® Calibration Kit, Set A, includes aliquots of these four calibrators at a 100X 
concentration, along with a calibration buffer for use as a diluent to create a spectral calibration plate for each dye.

Before performing the following dye calibration, we recommend performing a background calibration. Follow the 
guidelines in the instrument manual to perform a background calibration using the background plate provided by the 
instrument manufacturer.

Materials to Be Supplied By the User

• Plexor® Calibration Kit, Set A (Cat.# DC1500)

• background plate provided with the 7500 or 7500 Fast Real-Time PCR Systems Spectral Calibration Kit I 
(Applied Biosystems)

• real-time PCR instrument and related consumables (i.e., appropriate PCR plate and plate covers)

1. Thaw the four concentrated calibrators (fluorescein, CAL Fluor® Orange 560, CAL Fluor® Red 610 and IC5) and 
Plexor® 1X Calibration Buffer.

2. Vortex the concentrated calibrators and Plexor® 1X Calibration Buffer to mix for 10 seconds. Do not centrifuge 
the spectral calibrators after vortexing.

3. For each spectral calibrator, dilute each individual spectral calibrator 1:100 in Plexor® 1X Calibration Buffer, as 
described in Table 5.

Table 5. Preparation of Calibrators for Calibration Plate.

Component Fluorescein
CAL Fluor® 
Orange 560

CAL Fluor®  
Red 610 IC5

Concentrated 
Calibrator

 
22µl

 
22µl

 
22µl

 
22µl

Plexor® 1X 
Calibration Buffer

 
2178µl

 
2178µl

 
2178µl

 
2178µl

4. Vortex the diluted spectral calibrators for 10 seconds to mix. Do not centrifuge the spectral calibrators after 
vortexing.

5. For each diluted spectral calibrator, dispense 20µl to all 96 wells of a 96-well optical plate. Record the bar code 
number or mark the side of the plate skirt to designate the fluorescein, CAL Fluor® Orange 560, CAL Fluor® Red 
610 and IC5 spectral calibration plates.

6. Apply the appropriate plate seal to each plate. Protect plates from light.

7. Centrifuge plates briefly.
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5.A. Calibration Protocol for SDS Software, Version 1.4 (continued)

8. Follow the protocol in the instrument installation and maintenance guide to perform the calibration with the four 
plates. When required, define fluorescein as “FL”, CAL Fluor® Orange as “CO560” , CAL Fluor® Red as “CR610” 
and IC5 as “IC5”. These designations will be used during instrument programming, data import into the Plexor® 
Analysis Software and final reporting.

 Note: Each plate calibration takes ~10 minutes. After calibration, store the calibration plate, protected from 
light, at –20°C. Reuse the plate when reanalysis is necessary. Calibration plates can be stored for up to a year and 
should not be reused more than four times.

5.B. Reaction Plate Setup

When using the Plexor® HY System for the first time, we recommend programming the instrument (Section 5.C) before 
assembling the reactions. Once you are familiar with the programming process, the instrument can be programmed 
after reaction setup.

Materials to Be Supplied By the User
(Solution compositions are provided in Section 8.M.)

• sterile, aerosol-resistant pipette tips

• pipettes dedicated to pre-amplification work

• real-time PCR instrument and related consumables, such as the appropriate PCR plate and plate covers

• TE–4 buffer

• Plexor® Analysis Software (forensic release)

Template Preparation

Change gloves often, especially after handling high-concentration DNA. These instructions use 2µl of template DNA 
per reaction. The sample volume can be increased as long as the final reaction volume stays constant. Sample volumes 
and final reaction volumes must be the same for both the DNA standards and the unknown samples, allowing the DNA 
standards to be considered as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume). The standard 
curve described below uses DNA standards in the range of 3.2pg/µl to 50ng/µl. These values can be modified if 
desired. See Section 8.B.

Sample DNA Templates (Unknowns)

Use 2µl of sample DNA per reaction. Performing duplicate analysis of each sample DNA and averaging the 
quantification results can reduce variability. The sample DNA can be diluted in TE–4 buffer, if desired.
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DNA Standards

The Plexor® HY System is supplied with the Plexor® HY Male Genomic DNA Standard, 50ng/µl. This DNA is a mixture 
of human male DNA. Use of other DNA (e.g., DNA isolated from a cell line) as a standard is not recommended.

Serial dilutions of the DNA standard are amplified in the same plate as the unknown samples, and the results are used 
to generate a standard curve in the autosomal (fluorescein) and Y (CAL Fluor® Orange 560) channels to determine the 
concentrations of unknown samples. We recommend performing duplicate amplification reactions with each dilution of 
the DNA standard. Use of a dedicated set of pipettes can increase run-to-run consistency. Use the same pipettes to 
dispense the DNA standards and unknown samples.

!  Multiple freeze-thaw cycles of the Plexor® HY Male Genomic DNA Standard, 50ng/µl, can increase variability in 
the standard curve. High-molecular-weight DNA may form aggregates or concentration gradients when frozen, 
which may result in sampling error. Store the DNA standard at 4°C overnight before using it for the first time 
and vortex prior to use. We recommend long-term storage at 2–10°C.

1. Thaw and vortex the Plexor® HY Male Genomic DNA Standard, 50ng/µl, at high speed for 10 seconds. After 
initial thawing, store at 2–10°C.

2. Prepare fresh serial dilutions of the Plexor® HY Genomic DNA Standard as indicated in Table 6. Vortex each 
dilution for 10 seconds before removing an aliquot for the next dilution. Be sure to change pipette tips between 
dilutions. Change gloves after handling high-concentration DNA.

Table 6. Serial Dilution of the Plexor® HY Genomic DNA Standard.

Concentration Volume of DNA Volume of TE–4 Buffer

50ng/µl Use undiluted DNA 0µl

10ng/µl 10µl of undiluted DNA 40µl

2ng/µl 10µl of 10ng/µl dilution 40µl

0.4ng/µl 10µl of 2ng/µl dilution 40µl

0.08ng/µl 10µl of 0.4ng/µl dilution 40µl

0.016ng/µl 10µl of 0.08ng/µl dilution 40µl

0.0032ng/µl 10µl of 0.016ng/µl dilution 40µl

Note: We do not recommend storing diluted standards.
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5.B. Reaction Plate Setup (continued)

No-Template Control

Include a no-template control (NTC) reaction for each set of reactions. Add 2µl of TE–4 buffer to these reactions in 
place of the template DNA. There should be no amplification product (i.e., <1.0pg/µl with a 2µl input volume) detected 
in the NTC reaction. Amplification of >1.0pg/µl of DNA in the NTC reaction indicates nonspecific amplification or the 
presence of contaminating DNA.

Note: The Plexor® HY System is extremely sensitive. The NTC reaction may show amplification products in the 
subpicogram range.

Reaction Setup

1. Thaw the Plexor® HY 2X Master Mix, Plexor® HY 20X Primer/IPC Mix and Water, Amplification Grade.

 Note: Do not thaw the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix at temperatures above 
room temperature.

2. Vortex the Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix for 10 seconds to mix. Do not 
centrifuge after vortexing, as this may cause the primers to be concentrated at the bottom of the tube.

3. Determine the number of reactions to be set up. This should include negative control reactions. Increase this 
number by 10–15% to compensate for pipetting error. While this approach does require using a small amount 
of extra reagent, it ensures that you will have enough PCR master mix for all samples. It is critical that the same 
reaction mix is used for the entire run.

4. Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY 2X Master Mix and Plexor® 
HY 20X Primer/IPC Mix as indicated in Table 7. The reaction mix will be used to perform the NTC reaction and 
amplify samples and DNA standards. To amplify a larger input template volume, see Section 8.B.

Table 7. Preparation of Reaction Mix for Quantification Assays (assumes 2µl of template per reaction).

Component Volume (Per Reaction)

Plexor® HY 2X Master Mix 10µl

Water, Amplification Grade 7µl

Plexor® HY 20X Primer/IPC Mix 1µl

final volume 18µl

5. Vortex for 10 seconds to mix. Do not centrifuge after vortexing.

6. Add 18µl of the reaction mix prepared in Step 4 to each of the appropriate wells of an optical-grade PCR plate.

7. Add 2µl of TE–4 buffer to the NTC reactions (Figure 22).

8. Add 2µl of DNA standard or unknown sample to the reaction mix in the appropriate wells (Figure 22). Duplicate 
amplification of standards is required. Duplicate analysis of unknown samples and subsequent averaging of the 
DNA concentration will reduce the impact of variability due to pipetting, sampling or amplification.

9. Seal the plates with manufacturer-approved optical caps or optical adhesive cover using the applicator.
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10. Centrifuge the plate briefly to collect the contents of the wells at the bottom. The plate is ready for thermal 
cycling. Protect the plate from extended light exposure or elevated temperatures before cycling. Handle the plate 
by the edges, and avoid touching the bottom of the plate.
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Figure 22. Schematic diagram showing distribution of the diluted DNA standard and unknown samples 
(UNK) in a 96-well PCR plate.

5.C. Instrument Setup and Thermal Cycling for SDS Software, Version 1.4

General Setup

1. Open the 7500 or 7500 FAST sequence detection system (SDS) software.

2. Select “File”, then “New”.

3. In the New Document Wizard window that appears, select the following:

Assay: Absolute Quantification (Standard Curve)

Container: 96-Well Clear Plate

Template: Blank Document

Run Mode (7500 FAST only): Standard 7500

4. Select “Next”.
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5.C. Instrument Setup and Thermal Cycling for SDS Software, Version 1.4 (continued)

5. For the first use only, select “New Detector...” in the Select Detectors section of the New Document Wizard 
window. The New Detector window will appear (Figure 23).
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Figure 23. Create a detector with the New Detector window.

a. Select “New Detector”. Enter “Autosomal” for the detector name, “FL” as the reporter dye and “(none)” as 
the quencher. Select “OK”.

b. Select “New Detector” again, and enter “Y” for the detector name, “CO560” as the reporter dye and 
“(none)” as the quencher. Select “OK”.

c. Select “New Detector” once more, enter “IPC” for the detector name, “CR610” as the reporter dye and 
“(none)” as the quencher. Select “OK”.
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6. Highlight the line with the appropriate detector name and reporter dye for the assay. Select “Add”  
(Figure 24). Repeat for each fluorescent dye being used.

68
19

TA

Figure 24. Selecting the detectors and passive reference in the New Document Wizard window.

7. Select “IC5” for the “Passive Reference” from the drop-down box.

8. Select “Next”.
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5.C. Instrument Setup and Thermal Cycling for SDS Software, Version 1.4 (continued)

9. In the top window, check the box for each detector (Figure 25).

10. In the bottom panel, highlight the wells that are being used (Figure 25).

!  Do not highlight wells that are not being used (i.e., wells that do not contain reaction mix). Including unused 
wells will significantly affect the scale of the X and Y axes when viewing the data.
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Figure 25. Selecting dyes in the New Document Wizard window.

11. Leave “Task” as “Unknown” for all detectors.

 Note: Do not assign or change task (i.e., sample type, such as standard) or quantity during instrument setup. 
The SDS software, version 1.4, will not export this information with the data.

 Sample names can be entered into the SDS software, version 1.4, exported and imported into the Plexor® 
Analysis Software as a separate file (Section 5.D). Alternatively, names can be entered in the Plexor® Analysis 
Software or can be copied and pasted into the Plexor® Analysis Software from a Microsoft Excel® spreadsheet.

12. Select “Finish”.
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Thermal Cycling Program

The thermal cycling program is shown in Table 8. Figure 26 illustrates the final thermal cycling program.

Table 8. Thermal Cycling Program.

Step Temperature Time Number of Cycles

Initial denaturation: 95°C 2 minutes 1 cycle

Denaturation:

Annealing and extension:

95°C

60°C

5 seconds

35 seconds
38 cycles

Melt temperature curve: Use the default “Dissociation Function” settings.
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Figure 26. The final thermal cycling program for the Plexor® HY System. The sample volume should be 20µl, 
and the data collection option should be “Stage 2, Step 2 (60.0 @ 0:35)”.

1. Select the Instrument tab (Figure 26).

2. The default program includes two hold stages. Highlight and change the initial hold step, Stage 1, to 95.0 for 
2:00.

3. Delete Stage 2 by holding down the Shift key and selecting the stage to highlight it. Once selected, press “Delete”.
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5.C. Instrument Setup and Thermal Cycling for SDS Software, Version 1.4 (continued)

4. The next stage, which is now Stage 2, is a cycling program. Highlight and change Stage 2, Step 1, to 95.0 for 
0:05.

5. Highlight and change Stage 2, Step 2, to 60.0 for 0:35. Change “Reps” (repeat number) in Stage 2 to 38.

6. Change “Sample Volume (µL)” to 20.

7. Stage 2, Step 2 should be highlighted in yellow to indicate data collection. If it is not, select “Stage 2, Step 2 
(60.0 @ 0:35)” for “Data Collection”.

8. Make sure “9600 Emulation” is unchecked (7500) or “7500 Standard” run mode is indicated (7500 FAST).

9. Select “Add Dissociation Stage” in Stage 3. No modifications to the dissociation program are required. For the 
7500, the “9600 Emulation” must be unchecked before adding this stage.

!  When a dissociation curve is included in a thermal cycling program, the SDS software, version 1.4, may expect 
SYBR® green as the dye choice (this is software version-dependent). A message may appear when saving  
(Figure 27) or starting (Figure 28) an experiment. Select “Yes” and continue.

10. Choose “File”, then “Save As” to save the file.

 Note: The instrument setup and thermal cycling program can be saved as a template for future use. To do so, 
choose “File” and then “Save As”. Select “SDS Template” as the file type, and then save the file. This template can 
be opened by selecting “File”, then “Open” and used for future assays.
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Figure 27. The message that may appear when saving a document with a dissociation curve in the thermal 
cycling program (this is SDS software version-dependent).
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Figure 28. The message that may appear when starting an experiment with a dissociation curve in the 
thermal cycling program (this is SDS software version-dependent).

11. Place the PCR plate into the instrument, and immediately press “Start” to begin thermal cycling.

!  Prolonged exposure of the reactions to high temperatures or light before thermal cycling might adversely affect 
the final results.
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5.D. Preliminary Data Analysis and Data Export from SDS Software, Version 1.4

!  Before data can be analyzed using the Plexor® Analysis Software, the raw data must be analyzed in the SDS 
software and then exported. Two files must be exported: one with amplification data and one with melt/
dissociation data. Be sure to use a descriptive name when naming these files so that it is clear which file contains 
the amplification data and which file contains the dissociation data, and that the files are related.

The Applied Biosystems 7500 and 7500 FAST Real Time PCR Systems export data in a comma-delimited (.csv) file 
format. In some situations, the exported file may need to be converted to a comma-delimited file before importing 
(Section 8.C).

1. Go to the Analysis menu in the SDS software, and select “Analyze” or select the green arrow icon if it is still 
active. The raw data must be analyzed using the SDS software prior to export.

2. To export the amplification data, open the SDS software and select “File”, “Export” and then “Delta Rn”. Save 
this .csv file with an appropriate name.

3. To export the melt/dissociation data, select “File”, “Export”, “Dissociation” and then “Raw and Derivative Data”. 
Save this .csv file with an appropriate name.

 Notes:

1. If the data will be analyzed on a separate computer, save the files on removable storage media or an  
accessible network location for data transfer. These files are now ready for use with the Plexor® Analysis  
Software.

2. When a dissociation curve is included in a thermal cycling program, the SDS software, version 1.4, may  
expect SYBR® green as the dye choice (this is software version-dependent). A message will appear when 
analyzing an experiment (Figure 29). Select “Yes” and continue.
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Figure 29. The message that may appear when analyzing an experiment with a dissociation curve in the 
thermal cycling program (this is SDS software version-dependent).

4. To export Sample Names (if specified during setup; Section 5.C), select “File”, “Export” and then “Sample Set-up”. 
Save this .txt file with an appropriate name.
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5.E. Data Import into the Plexor® Analysis Software from SDS Software, Version 1.4

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor® Analysis Software. The 
Plexor® Analysis Software and instructions for software installation can be downloaded free of charge from the 
Promega Web site at: www.promega.com/plexorhy/

When exporting data for use with the Plexor® Analysis Software, be sure to assign descriptive names to the files so that 
related amplification curve and melt curve files (e.g., files generated using the same data) can be easily identified during 
data import.

Note: Closing other programs before launching the Plexor® Analysis Software can increase the operating speed.

1. To launch the Plexor® Analysis Software, go to the “Start” menu and select “Programs” and then “Plexor”. Select 
“Analysis Desktop”.

 Notes:

1. A shortcut can be placed on the desktop by right-clicking on the Analysis Desktop, selecting “Copy” and 
then right-clicking on the Windows® desktop and selecting “Paste Shortcut”.

2. A master template for routine settings import and analysis can be created. See Section 8.H for details  
concerning this option.

2. In the File menu, deselect “Set Passive Reference On Import”. The SDS software exports data that are already 
normalized to the passive reference. A separate import of the passive reference dye channel (IC5) is not necessary.

3. In the File menu, select “Import New Run”, or select the icon: 

4. Optional: Enter an assay name in the Assay Setup screen, Step 1 (Figure 30). This screen is used to enter 
information about the type and format of data that will be used for each assay.
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Figure 30. Step 1 – Assay Setup screen.
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5. Select “Applied Biosystems 7500 SDS v.1.4 and prior” as the instrument type for the Applied Biosystems 7500 
and 7500 FAST real time PCR systems.

6. Select “Add Target” three times.

7. For each dye, assign a target name, enter the correct dye name (FL for Autosomal, CO560 for Y and CR610 for 
IPC) and indicate there is amplification data and melt (dissociation) data to be analyzed for that dye.

 Notes:

1. The name of the dye must be the same as that in the data file (Section 5.D).

2. Be sure “Amplification” and “Melt” are checked for all three targets.

3. You can select "Export" and save the assay setup as an Assay Template file (.atp) for subsequent analysis. 
See Section 8.H for more details.

8. Select “Next”.

9. Enter information specific to your run in the Run Info screen, Step 2 (Figure 31). Details such as the date, notes, 
title, etc., also can be entered. These fields are optional.
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Figure 31. Step 2 – Run Info screen.

10. Select “Next”.
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5.E. Data Import into the Plexor® Analysis Software from SDS Software, Version 1.4 (continued)

11. Use the File Import screen, Step 3 (Figure 32), to specify the data files exported from the instrument in  
Section 5.D. Use “Browse” to locate the appropriate exported amplification and dissociation data files.

!  When analyzing data with the Plexor® Analysis Software, be sure to choose the amplification file and melt file 
generated during the same run. The file names assigned when exporting data must be descriptive so that the 
appropriate files can be easily identified and imported into the Plexor® Analysis Software.

 Note: “Advanced Options” can be used to create templates for routine plate setups and analysis conditions. See 
Section 8.H for details concerning these advanced options and an explanation of the default analysis settings.
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Figure 32. Step 3 – File Import screen.

12. Select “Finish” to complete data import and open the Analysis Desktop.

 Notes:

1. If the names of the dyes you have entered do not match those listed in the data files, an error message  
will appear (Figure 33). If this message appears, return to the Assay Setup screen, Step 1 (Figure 30). 
Click on the Dye field under the Data Collection heading, and enter the dye names exactly as shown in the 
error message after “Found:”. Any dye name entered must exist in the data file. Repeat Steps 7–12 of this 
protocol.

2. If sample names were defined and exported from the SDS software, version 1.4, they can be imported by 
selecting “Apply Sample Names from SDS Export File (.txt)” in the File menu. In the browser window that 
opens, find and select the sample set-up file exported from the instrument software (Section 5.D).
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Figure 33. The Dye Mismatch error message.

6. Data Analysis with the Plexor® Analysis Software

After data import is complete (Sections 4.E and 5.E), the PCR Curves tab of the Analysis Desktop is displayed  
(Figure 34).

Note: The columns presented within any report or table, such as the graph legends shown in Figures 34 and 38, can be 
customized to suit your preferences:

• Columns can be reordered by placing the cursor over the column header, click-hold on column header and drag 
to the desired location.

• To add or delete columns, right-click within the table, select “Change Columns Shown” and a list of all possible 
columns for display will appear. Check or uncheck the boxes as appropriate.

• Data can be sorted by any criterion by clicking on the column header. A subsequent click of the column header 
will reverse the sort order. Data can be sorted by a second criterion by holding the Shift key and clicking on 
another column header. Shift-clicking on the column header subsequent times will change the secondary sort 
order from ascending to descending, then will remove the secondary sort.

• The “Well” column displays the physical location of samples in the plate. The default sort order is by column; to 
sort by row, right-click within the table and toggle-on the option “Sort by Row”.

• Concentration values (“Conc” column) are presented in scientific notation by default. To present the data in 
standard notation, right-click within the table and toggle-off the option “Scientific Notation”.

• To save modifications to the table or report display, right-click within the table and toggle the option “Save table 
defaults”.
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6. Data Analysis with the Plexor® Analysis Software (continued)
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Tools

Tab selection

Amplification
curves window

Melt curves
window

Well selector

Figure 34. The PCR Curves tab of the Analysis Desktop. The amplification curves window, melt curves window 
and well selector are indicated.

Unknown

No-template control

Standard sample. The concentration is entered in a pop-up window following designation 
of a well as a standard.

Selecting the wells and choosing the Create Dilution Series icon can automatically create a 
titration curve across several wells.

Positive control

Color assignment

Figure 35. The icons used to define samples in the Plexor® Analysis Software.
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6.A. Sample Definition

Sample definition, color selection and DNA concentration of standards will be entered for all dyes.

Use the well selector, which is shown in Figure 34, to select and define each well or group of wells. Choose one of the 
icons shown in Figure 35 to define the samples.

Colors can be assigned to samples to provide distinction to the displayed data. Select the samples, and then select 
“Color Assignment” to apply a color to the selected sample(s). Assigning or changing a color does not alter the 
information associated with a sample. For example, the DNA concentrations of standards will be retained if the display 
color associated with those samples is changed.

A sample or set of samples can be permanently deleted from a Plexor® analysis. Go to the PCR Curves tab, and select 
the samples. Use the delete key, or select “Remove Selected Wells” in the Edit menu.

These instructions are for DNA standard setup as described in Sections 4.B and 5.B, using concentrations in ng/µl. The 
volume of template used for the DNA standard reactions must be the same as that for unknowns.

1. Define the DNA standards.

a. Use the well selector to highlight wells that contain DNA standards.

b. Select the Create Dilution Series icon: 
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c. Confirm that the series selected is “Vertical Series” and the series is “Decreasing”. Enter 50 for the starting 
concentration and 5 for the dilution factor. See Figure 36.

Notes:

1. Results with the 0.0032ng/µl dilution of the DNA standard may exhibit increased variability compared 
to those of other standard dilutions. Definition of the 0.0032ng/µl dilution as a standard is optional (see 
Section 6.C). The 0.0032ng/µl dilution should be included on each plate. Amplification of the 0.0032ng/µl 
samples will confirm the sensitivity of the assay in each run.

2. The software does not accept commas or unit definitions in the concentration assignments.

3. The unit definition for DNA quantity can be changed throughout the data analysis to describe concentra-
tions in pg/µl rather than ng/µl. To report concentrations in pg/µl, change the input values as follows:

 In Step 1.c above, confirm that the series selected is “Vertical Series” and the series is “Decreasing”. Enter 
50,000 for the starting concentration and 5 for the dilution factor.

 In Section 6.D, Steps 6–8, select the check boxes for picograms and enter values as pg/reaction and pg/µl.

 Results in the report sections will now be in pg/µl.
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6.A. Sample Definition (continued)
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Figure 36. The Assign Dilution Series window.

2. Define the no-template control reactions.

a. Use the well selector to highlight the wells that contain NTC reactions.

b. Select the NTC icon: 

3. Assign or edit sample names.

a. Select the Sample Names tab (Figure 37). Select the well, and enter the desired sample name. Repeat to 
enter sample names for other wells.

b. Enter the same sample name for duplicate samples. See Note 3.

c. Names can be copied from a Microsoft Excel® spreadsheet, provided that the cells are arranged in the same 
array as your samples (e.g., 8 × 12). Highlight the sample names in the spreadsheet, and select “Copy”. In 
the Edit menu of the Plexor® Analysis Software, select “Paste Sample Names From Template” or use the 
Control T shortcut. The layout of the sample names in the spreadsheet must be the same as the layout of the 
samples within the PCR plate.

d. After all edits are made, click “Accept Changes” at the bottom of the Sample Names window.

 Notes:

 1.  If Sample Names were specified in the run setup (HID software and SDS software, version 2.0  
and higher) they may be imported during data import (see Section 4.D). If Sample Names were 
specified in the run setup (SDS software, version 1.4 and lower) they may be imported after data 
import (see Section 5.E).

 2.  In naming samples avoid the use of characters that are disallowed for filenames or that may be used 
as delimiters, such as ; : . , \ / * ? " < > |.

 3. Quantification results for samples with identical sample names can be averaged by the  
 normalization tool (see Section 6.D).
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Figure 37. The Sample Names tab.

6.B. Adjusting the Expected Target Melt Temperature

Set the expected target melt temperature and the expected target melt temperature range. Failure to set the range for 
the expected target melt temperature correctly will cause the results to be incorrectly reported in the graph legend and 
reports (Sections 6.D and 6.H). The expected melt temperature range must be adjusted for all three dye channels (FL, 
CO560 and CR610 dyes).

The average expected target melt temperature values are instrument-dependent. However, the average expected target 
melt temperature for the autosomal target (FL dye) is generally in the range of 79–81°C, and the average expected 
target melt temperature for the Y-chromosomal target (CO560 dye) is generally in the range of 81–83°C. The average 
expected target melt temperature for the IPC (CR610 dye) is generally in the range of 79–81°C, but for some samples, 
the IPC Tm value can fall outside this range by as much as 2°C. Adjust the lower bounds of the expected melt range to 
encompass these samples, if desired. Amplification data, in particular the Cq value, are the primary means of analyzing 
IPC data.

1. Select the PCR Curves tab. The default setting for the expected target melt temperature is 90.0, and the default 
target Tm range is +/–1.5°C.

2. Select wells containing the DNA standards. The Tm for each selected sample will be displayed in a table to the 
right of the graph (Figure 38). The expected target melt temperature and associated target melt temperature 
range for all samples in this dye channel should be set based on the Tm of these standards.

3. In the melt curves window, move the mouse so that the arrow is over the expected target melt temperature line, 
and drag the line to the midpoint of the melt curves. Alternatively, double-click on the line, and enter the desired 
temperature. See Notes 1–6.
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6.B. Adjusting the Expected Target Melt Temperature (continued)
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Figure 38. The target melt temperature is displayed in a table to the right of the graph.

 Notes:

1. The target melt temperature range can be adjusted manually. Move the mouse so that the arrow is over the 
upper or lower limit, and drag the limit to the desired temperature. Alternatively, upper and lower limits 
can be adjusted by double-clicking on the appropriate lines and entering an exact value in the pop-up  
window that appears.

2. The melt threshold is the level of signal that must be reached for the Plexor® Analysis Software to “call” the 
melt results. Target Tm indicators are included in the table to the right of the amplification and melt curve 
windows. See Section 8.F for advanced options to set the melt threshold.

3. A “Yes” or “No” in the Tm? column indicates whether a sample Tm is within the expected target melt 
temperature range. A “No Call” in this column indicates that the melt curve displays the expected target 
melt temperature but there is insufficient amplification product to cause the melt curve to cross the melt 
threshold.

4. The “Tm#” is the number of peaks that cross the melt threshold line. More than one peak indicates  
heterogeneous amplification products. This may be due to nonspecific amplification.

5. An increase in Tm for the unknowns relative to that of the DNA standards may be the result of impurities 
remaining after DNA extraction. To remove these impurities, increase the number of wash steps or  
comparable steps.

6. The default display of the melt curve has not been processed beyond the melt curve derivation. In some 
cases it may be helpful to view a smoothed melt curve using a Gaussian fit of the raw melt curve data to  
deemphasize minor variability in the melt data. To change the display, right-click on the Melt Curves  
window, choose “Select Melt Data”, then select “Gaussian Fit”. Note that any melt curve that does not  
meet the melt threshold will be rendered as a straight line (y intercept = 0) in this view.
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6.C. Generating a Standard Curve and Determining Concentrations of Unknowns

Amplification results from the dilution series of the DNA standard are used to generate a standard curve. This standard 
curve is used to determine the DNA concentration of unknown samples. Samples for generating the standard curve 
must be designated as standards (Section 6.A). Standard curves must be generated for the autosomal (FL) and Y 
(CO560) channels.

The Plexor® Analysis Software performs a linear regression to the standard dilution series data and calculates the 
equation for the best-fit line (the standard curve). The equation is in the form of y = mx + b, where x = log 
concentration and y = Cq (if using the software default settings). The R2 value is a measure of the fit of the data points to 
the regressed line. The slope (m in the equation) is an indication of the PCR efficiency. A slope of –3.3 indicates 100% 
PCR efficiency (i.e., the number of copies of amplification product is doubled at each cycle). The y intercept (b in the 
equation) is defined as the y value (Cq) when x (log concentration) equals 0. Therefore, b corresponds to the Cq for a 
sample with a concentration of 1ng/µl (log10(1) = 0). If the value for b changes significantly from run to run without a 
change in the slope or R2 value of the standard curve, then this suggests the DNA standard was not sufficiently mixed 
before use or has degraded.

In general, the standard curve for the autosomal target (FL) has an average slope (m) in the range of –3.2 to –4.0 and 
an R2 value ≥0.990. The standard curve for the Y-chromosomal target (CO560) generally has an average slope (m) in 
the range of –3.0 to –3.6 and an R2 value ≥0.990.

Low R2 values (R2 <0.98) may be due to variability in the amplification results for the replicate samples of the 
0.0032ng/µl dilution. The 0.0032ng/µl dilution may exhibit increased variability compared to the other dilutions of 
the DNA standard, most notably in the autosomal reactions. If a low R2 value is observed, change the sample type for 
the 0.0032ng/µl standards to “unknown”. The software will automatically incorporate this change into the standard 
curves. If this does not improve the R2 value, proceed to Section 7 and review the comments for “Variability in signal 
among replicate samples”, “Nonlinear standard curve, low R2 values <0.98” and “Slope is outside of the range specified 
in Section 6.C”.

1. In the autosomal channel (FL tab), select all samples and DNA standards. Select “Add Standard Curve” to 
generate a standard curve and determine DNA concentrations of the unknowns based on the standard curve.

 Add Standard Curve

2. Repeat Step 1 for the Y channel (CO560 tab).

3. Select the Standard Curves tab to view the standard curves (Figure 39). One subtab shows the autosomal (FL) 
standard curve, and a second subtab displays the Y (CO560) standard curve. The default display shows the log 
concentration on the X axis and quantification cycle on the Y axis.

 Note: All samples analyzed together will be displayed in the Standard Curve by default. To view only the plot of 
the standards, right-click in the Curve panel and the “Display Only Standards” option will appear. This option 
can be toggled on or off.
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6.C. Generating a Standard Curve and Determining Concentrations of Unknowns (continued)
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Figure 39. The Standard Curves tab.

4. View DNA concentrations for all samples, including the unknown samples, in the table next to the standard curve 
graph (Figure 39). The calculated concentrations also can be viewed in the sample details report (Section 6.H).

 Note: Samples that do not cross the amplification threshold, such as the no-template controls, are listed in the 
graph as not having a valid Cq value.

6.D. Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC  
Parameters

After generating standard curves and quantifying unknowns for autosomal and Y-chromosomal DNA, the quantification 
results can be used to prepare short tandem repeat (STR) amplifications. A normalization tool is incorporated into the 
Plexor® Analysis Software to help determine: a) which samples are suitable for analysis, b) which samples require 
dilution, c) which samples may need repurification for accurate quantification, and d) how much sample should be 
added to your autosomal STR amplifications (e.g., PowerPlex® Fusion reactions) or Y-chromosomal STR amplifications 
(e.g., PowerPlex® Y23 reactions).

DNA concentrations determined by autosomal and Y-chromosomal quantification may differ. Quantitative PCR results 
and the copy number of the target sequences can vary. You may see small differences in the quantification results for the 
same sample. The preferred DNA amount for subsequent STR analysis should be defined through laboratory validation 
of the STR assays in conjunction with Plexor® HY quantification.

Note: Quantification results for samples with identical sample names can be averaged by the normalization tool.
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Following normalization, a new Forensics subtab will be displayed under “Reports”.

In situations where multiple people use the same computer, the parameters entered in Steps 2–8 will be retained for 
each Windows® user account when the Plexor® Analysis Software is closed and reopened, so there is no need to repeat 
Steps 2–8 for subsequent runs unless the parameters change.

Note: If desired a forensic template for routine setups and for master template use can be created. Select "Export", and 
save the .ftp file in a location of choice. For more information on template use, see Section 8.H.

1. Select “Set Normalization and IPC Parameters” in the Forensics menu.

2. In the dialog box that appears (Set STR Normalization and IPC Parameters; Figure 40), be sure that the box next 
to “disable volume normalization (show concentrations and Cq only)” is not checked. If this box is checked, STR 
normalization data will not be displayed in the subsequent forensic report. See Section 6.F.

3. Optional: If the DNA standards were defined in pg/µl (Section 6.A, Step 1), select the check box to set units as 
picograms. The default display is as nanograms.

4. Select the Autosomal STRs tab (Figure 40).
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Figure 40. The Set STR Normalization and IPC Parameters window.
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6.D. Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC 
Parameters (continued)

5. Enter the preferred DNA quantity per STR amplification reaction.

6. Enter the minimum and maximum input volumes of sample (in µl) for each STR reaction. The limits for pipetting 
of sample should be defined in your laboratory. Minimum volume is generally defined by the limits of the pipettes 
being used and laboratory guidelines. Maximum volume will often be defined by the STR reaction volume or 
laboratory guidelines.

 If a single sample volume for STR amplification setup is desired, narrow this range by entering the same volume 
for the minimum and maximum volumes. A broad range of input target quantities and volumes will limit the 
number of samples requiring dilution.

7. Enter the minimum and maximum sample DNA quantities (in ng/reaction or select the check box for picograms 
and enter the DNA as pg/reaction), indicating the lowest and highest amounts of DNA known to produce 
acceptable STR profiles, as demonstrated through laboratory validation of the STR assays in conjunction with the 
Plexor® HY System.

8. Enter the preferred concentration (in ng/reaction, or pg/reaction if selected above) to which overconcentrated 
samples will be diluted. The concentration entered must achieve the preferred DNA quantity per reaction entered 
in Step 5 within the range of the minimum and maximum input volumes chosen in Step 6.

9. Select the Y-STRs tab, and repeat Steps 5–8.

10. Select the Internal PCR Control (IPC) tab (Figure 41). If desired, modify the IPC Cq threshold, which defines the 
acceptable difference between the IPC Cq values in DNA standards and samples. The default value is 2 cycles. If 
the IPC Cq value in a sample differs from the IPC Cq value in the DNA standard by more than 2 cycles, “Check 
IPC” will be displayed in the Forensics report for that sample. See Section 6.E for more details about interpreting 
IPC results and modifying this value.

 Note: If desired a forensic template for routine setups and for master template use can be created. Select  
"Export", and save the .ftp file in a location of choice. For more information on template use, see Section 8.H.
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Figure 41. The Internal PCR Control (IPC) tab.

11. After values for all three tabs [i.e., Autosomal STRs, Y-STRs and Internal PCR Control (IPC)] are entered, select 
“OK”.
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12. The Forensics report will be displayed (Figure 42).

 Note: The Forensic Report can be modified to suit your preferences similarly to the other reports and legends 
(e.g., column shown, sort order, number format, averages, etc.). The display can be changed by right clicking on 
the table and selecting the desired options. The report can be sorted by any column by selecting the header of 
that column. Columns can be rearranged by clicking and dragging the header to the new location.
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Figure 42. The Forensics report.

Definitions and Forensic Report Interpretation

[Auto]: Concentration of total human autosomal DNA in a sample in ng/µl (or pg/µl if DNA concentrations were 
entered as pg/µl).

[Y]: Concentration of human male DNA in a sample in ng/µl (or pg/µl if DNA concentrations were entered as pg/µl).

[Auto]/[Y]: Ratio of total human autosomal DNA concentration to male (Y) DNA concentration. A very high ratio is 
indicative of a “male/female” mixture with minimal male DNA. If the male contributor is of interest, samples with a 
very high ratio may benefit from Y-STR analysis in addition to, or instead of, autosomal STR analysis. Laboratory 
validation of the Plexor® HY System in conjunction with the preferred autosomal and Y-STR systems is required to 
determine a meaningful value upon which to base this decision.

Note: Due to some individual-to-individual variation in copy number of the autosomal target and Y-chromosomal 
target, a single male DNA may not have an [Auto]/[Y] value of 1.0. Additionally, quantitative real-time PCR has 
inherent variation, especially with samples that have higher Cq values (i.e., samples with lower DNA concentrations). 
This variation can be reduced by performing replicate analysis. [Auto]/[Y] values in the range of 0.4 to 2 are commonly 
observed in single-source male samples.

The [Auto]/[Y] ratio is not intended to identify minor female contribution in a male sample. This ratio should be used 
to form guidelines to suggest when Y-STR analysis may be a beneficial supplement to autosomal STR analysis (i.e., 
[Auto]/[Y] is between approximately 5 and 20) and when only Y-STR analysis is likely to produce a meaningful STR 
profile (i.e., [Auto]/[Y] <20). Laboratory validation of the Plexor® HY System, in conjunction with STR analysis, 
should be performed to determine these interpretation guidelines.
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6.D. Normalization of DNA Quantification Results for Input into STR Reactions and Setup of IPC 
Parameters (continued)

STR Dilution Status (Autosomal or Y): An indication of whether a sample contains DNA of adequate 
concentration to use directly in STR analysis or whether dilution is necessary. The status terms listed below are 
established by the values indicated in the Set STR Normalization and IPC Parameters window (Figure 40). Auto STR 
columns use autosomal quantification results and are intended to guide setup of autosomal STR reactions. Y-STR 
columns use Y-chromosomal quantification results and are intended to guide setup of Y-STR reactions.

• “No Target” indicates no DNA was detected.

• “Underconc.” indicates that DNA was detected, but the minimum acceptable DNA quantity (ng or pg per 
reaction) cannot be achieved with the maximum volume that was defined.

• “Below Target” indicates that the specified maximum volume of sample will deliver an acceptable quantity of 
DNA but less input DNA than the indicated preferred DNA quantity.

• “In Range” indicates that the preferred DNA quantity is achievable within the acceptable volume range.

• “Above Target” indicates that the specified minimum volume of sample will deliver an acceptable quantity of 
DNA but will deliver more input DNA than the preferred DNA quantity.

• “Overconc.” indicates that the maximum acceptable DNA quantity (ng or pg per reaction) cannot be achieved 
with the minimum volume that was defined. Samples will need dilution.

STR Volume (Autosomal or Y): The volume (µl) of sample that should be used in STR analysis. Auto STR columns 
use autosomal quantification results and are intended to guide setup of autosomal STR reactions. Y-STR columns use 
Y-chromosomal quantification results and are intended to guide setup of Y-STR reactions.

STR Quantity (Autosomal or Y): The quantity (ng, or pg if selected) of sample that will be input into the STR 
reaction using the indicated “STR Volume”. Auto STR columns use autosomal quantification results and are intended to 
guide setup of autosomal STR reactions. Y-STR columns use Y-chromosomal quantification results and are intended to 
guide setup of Y-STR reactions.

STR Dilution Factor (Autosomal or Y): The dilution factor necessary to achieve the desired concentration 
indicated in the Set STR Normalization and IPC Parameters window (Section 6.D, Step 7). Only samples indicated as 
“Overconc.” will have a dilution factor listed. Auto STR columns use autosomal quantification results and are intended 
to guide setup of autosomal STR reactions. Y-STR columns use Y-chromosomal quantification results and are intended 
to guide setup of Y-STR reactions.

IPC Status: An indication of whether the difference between the sample’s Cq values for the IPC and DNA standard is 
greater than the designated threshold in the Internal PCR Control (IPC) tab (Figure 41). A difference of less than the 
designated threshold is indicated as “OK”; a difference greater than the threshold is indicated as “Check IPC”.

Curves Status: “OK” indicates the following:

• The sample, if defined as a standard, shows amplification.

• The sample, if defined as a no-template control, shows no amplification.

• If a melt peak is present, the Tm is within the expected range.

“Check STD”, “Check NTC” or “Check Melts” will be displayed if these criteria are not met.

Note: It is acceptable for the 0.0032ng/µl DNA standard to display “No” or “No Call” in the “Tm?” column. Verify that 
if any subthreshold peak is present in the melt curve, this peak is within the expected target melt temperature range.
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6.E. Analysis of the Internal PCR Control

The IPC is amplified and detected in the CR610 dye channel under PCR Curves. These data can provide an indication 
of potential inhibition that may have affected the quantification data (FL and CO560 data). By comparing IPC Cq values 
for unknown samples with IPC Cq values for DNA standards, inferences regarding the presence of inhibitors can be 
made. Decreasing the IPC threshold above which a flag is shown (Figure 41) will increase the sensitivity to differences 
in the Cq values, while increasing the threshold will necessitate greater IPC Cq value differences to present the Check 
IPC flag.

Note: Data from samples are compared to data from DNA standards of similar autosomal Cq values. The IPC 
amplification is designed to be the most inhibition-sensitive or least robust amplification in the triplex.

• If the IPC Cq value of an unknown is several cycles higher than that of DNA standards with similar total DNA 
amounts, inhibition may have occurred and the quantification data are in doubt. Consider repurifying and  
requantifying the sample DNA.

 Note: High levels of total human DNA (>10ng/µl) can cause a slight delay in the IPC crossing the amplification 
threshold (1–2 cycles).

• IPC Cq value differences can be used to automatically flag potential inhibition in the Forensics report as described 
in Section 6.D, Step 10.

Laboratory validation with relevant inhibitors should be performed to determine criteria for detecting inhibition.

6.F. Forensic Report Without Normalization

The quantification results can be reported without normalization of volumes. This report shows quantification results 
and IPC status and curves status columns.

1. Select “Set Normalization and IPC Parameters” in the Forensic menu.

2. Check the box to disable volume normalization (show concentrations and Cq values only).

3. Select the Forensic tab in the Reports menu.

6.G. Data Export in a 96-Well Format

The quantification results can be exported in a 96-well format. The exported file is an Excel® spreadsheet, which can be 
used for automated PCR setup. This export is only possible after the instructions in Section 6.D are performed.

1. Select “Export 96-well Concentration” in the Forensics menu.

2. Select “Autosomal Concentrations” for the autosomal results, enter a file name and select “Save”.

3. Select “Y Concentrations” for the Y results, enter a file name and select “Save”.
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6.H. Supplemental Reports

In addition to the Forensics report described in Section 6.D, the Plexor® Analysis Software includes four report 
options: “Sample Details”, “Thresholds”, “Baseline Regions” and “Run Info”, which are included as subtabs in the 
Reports tab. To view these report options, select the Reports tab. Information is presented in a tabular format that can 
be copied, saved or printed using the provided icons. The saved data can be opened using Microsoft Excel® software.

Sample Details: The sample details report includes well location, sample name, dye channel, cycle threshold, thermal 
melt temperature, concentration (if applicable), whether the sample has the expected Tm and the number of melt curves 
that cross the melt threshold line (Figure 43).

A sample with a Cq value of “N/A” has an amplification curve that did not cross the amplification threshold.
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Figure 43. The Sample Details tab.

Thresholds: The thresholds report includes the numerical values for the thresholds in the current analysis  
(Figure 44). This information can be used to develop an analysis template for assays where the same or similar 
thresholds will be used on a routine basis. See Section 8.H for more information about creating an analysis template.
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Figure 44. The Thresholds tab.
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Baseline Regions: The baseline regions report includes the numerical values for the cycle number used in each 
sample (Figure 45).
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Figure 45. The Baseline Regions tab.

Run Info: The run info report includes information from the data import (Figure 46).

Import Files: The import files report includes information on the data import files (Figure 47).
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Figure 46. The Run Info tab.
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Figure 47. The Import Files tab.
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6.I. Saving and Printing the Analysis File

1. The Plexor® Analysis Software saves the analysis as an *.aan file. The current analysis can be saved at any time by 
selecting “Save Analysis File (.aan)” in the File menu.

2. Selected wells can be exported into a new analysis file. In the File menu, select “Export Selected Wells as New 
Analysis File (*.aan)”.

3. The analysis screen can be printed or saved as a screenshot. In the File menu, select “Save a Screenshot (.png)” 
or “Print a Screenshot”.

4. A run template and analysis template from an existing analysis can be exported and used in future analysis 
(Section 8.H).
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7. Troubleshooting

Symptoms Causes and Comments
Flat amplification curve in the amplification  Template was degraded or of insufficient quantity. Verify the  
curves window for autosomal and Y channels  integrity of the DNA template by electrophoresis.

but not the IPC. (i.e., the IPC Cq value of the  Be sure that the reactions were assembled correctly.

sample in question was similar to the Cq value  Thermal cycler was programmed incorrectly. Verify cycle times  
of the DNA standards, but there was no apparent  and temperatures (Sections 4.C and 5.C).

amplification for the autosomal and Y targets) Data collection settings were incorrect. Data collection must  
 occur during the extension step. The extension time must be  
 sufficient for data collection. Verify the data collection settings.

  The wrong dye or detector was selected. Be sure the selected 
detectors are appropriate for the fluorescent dyes used.

  The passive reference was set incorrectly. Be sure the passive 
reference is set as “IC5” (Figure 24) for SDS software, version 
1.4, only.

  The scale of the Y axis was inappropriate. If the scale of the Y 
axis is too broad, the change in fluorescence may not be visible. 
Adjust the scale of the Y axis.

Flat amplification curves in the amplification  Amplification inhibitor is present in the DNA template.  
curves window (i.e., no Cq values) for all channels,  Reduce the concentration or volume of the template in the  
or flat amplification curves for the autosomal and  reaction. Repeat the DNA purification if necessary

Y targets with high Cq values for the IPC Sample well(s) did not receive reaction mix. Examine the plate  
 to identify any empty wells. Redefine plate map in HID or SDS  
 software, omitting any empty wells. Reexport and reanalyze  
 the data (Sections 4.E and 5.E).

  The scale of the Y axis was inappropriate. If the scale of the Y 
axis is too broad, the change in fluorescence may not be visible. 
Adjust the scale of the Y axis.

  The Plexor® HY 2X Master Mix may have lost activity. Be sure 
to store the Plexor® HY System at –20°C to avoid loss of enzyme 
activity. Confirm instrument settings, and review the DNA 
standard amplification data to determine if there is a problem 
with the Plexor® HY System reagents.

  The Plexor® HY 20X Primer/IPC Mix was degraded. Minimize 
the number of freeze-thaw cycles.
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7. Troubleshooting (continued)

Symptoms Causes and Comments
Increasing fluorescence over time Be sure that the passive reference was defined correctly.

  The baseline region was set in a region with significant 
fluorescence fluctuation. The baseline within the baseline  
region should be flat. Manually adjust the baseline region 
(Section 8.D).

  The baseline region was set too close to the signal change. 
Manually adjust the baseline region (Section 8.D).

Two or more distinct melt curves or one  Check for signal bleedthrough. Calibrate the instrument as  
broad melt curve in the melt curves window instructed in Sections 4.A and 5.A.

No melt curve observed in the melt curves  Poor amplification. See causes and comments for “Flat  
window amplification curves in the amplification curves window”  
 symptoms above.

  Problems with data export or instrument analysis have occurred. 
Review the instructions for data export and instrument setup.

  Data collection settings were incorrect. Verify that the thermal 
cycling program and data collection settings are correct 
(Sections 4.C and 5.C).

  Incorrect files were imported. Be sure to import the proper files 
containing related amplification data and dissociation data.

  Instrument was programmed incorrectly. Verify that the thermal 
cycling program is correct (Sections 4.C and 5.C).

  Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Redefine plate map in HID or SDS 
software, omitting any empty wells. Reexport and reanalyze the 
data (Sections 4.E and 5.E).

  Melt Curve display was changed to “Gaussian Fit” mode, and 
selected samples do not meet the melt threshold. If “Gaussian 
Fit” mode is selected, the Plexor® Analysis Software draws as 
straight lines (zero slope, zero y-intercept) those curves that did 
not meet the melt threshold at the time of import, at the time of 
opening the *.aan file, or at the time of switching from “Raw 
Data” view to the “Gaussian Fit”. This indicates that these 
curves were not considered for melt peak calling (Exp Tm?). 
Switch the melt curve view to “Raw Data”.
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Symptoms Causes and Comments
Variability in signal among replicate samples Calibrate your pipettes to minimize variability when pipetting.

  Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; we recommend using a sample volume of 2µl or 
higher. If necessary, dilute the template so that larger volumes 
are pipetted.

  Some variation is normal. A difference of 1–2 cycles for the Cq 

values of replicates is within the normal variation associated 
with an exponential amplification reaction. Cq variation should 
be <2 cycles for replicates.

  There will be statistical variation in the amount of template in a 
reaction with targets present at low copy number. Poisson 
distribution predicts difficulty associated with reliable detection 
of dilute samples with few target molecules.

  Mixing was inadequate. Vortex reagents to mix well prior to 
pipetting.

  Plate performance can differ from manufacturer to 
manufacturer. Use plasticware recommended by the instrument 
manufacturer.

  Instrument was improperly calibrated. Calibrate instrument as 
instructed by the manufacturer. Perform a background check as 
directed by the manufacturer.

  Store the DNA at 4°C overnight to improve sampling 
consistency.

  Viscous samples (e.g., high-molecular-weight genomic DNA) are 
difficult to pipet accurately. Dilute the DNA template.

  The plate was not completely sealed. Carefully seal the plates to 
avoid evaporation.

  The baseline region was not set correctly. The baseline should be 
flat. The baseline region can be adjusted manually for each well 
to account for sample-to-sample variation (Section 8.D).

Fluorescence decrease observed in the  Reactions were contaminated with target DNA. Human DNA  
no-template control reaction   contamination will produce a melt product similar to that of the 

DNA standard amplifications. Clean workstations and pipettes 
with a mild bleach solution before and after use. Use new 
reagents and solutions. Take precautions to prevent 
contamination. Use separate bench spaces and pipettes when 
handling DNA.
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7. Troubleshooting (continued)

Symptoms Causes and Comments
Fluorescence decrease observed in the Decrease the cycle number to reduce accumulation of  
no-template control reaction (continued) nonspecific amplification products.

  An improperly calibrated instrument can lead to erratic 
fluorescence readings. Calibrate the instrument as instructed by 
the manufacturer.

Vertical fluorescence spikes or significant  Consult the instrument manufacturer’s user’s guide for  
“noise” in the amplification curve information about potential instrument problems that can  
 cause spikes or noise.

  No amplification or poor amplification for the entire plate. Poor 
amplification can lead to improper data scaling, making 
fluorescence measurements appear erratic. See possible causes 
and comments for “Flat amplification curves in the amplification 
curves window” symptoms above.

  Instrument was improperly calibrated. Calibrate instrument as 
instructed by the manufacturer.

  The passive reference was set incorrectly. Be sure that the 
passive reference is defined correctly.

  Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Redefine plate map in HID or SDS 
software, omitting any empty wells. Reexport and reanalyze the 
data (Sections 4.E and 5.E).

Small signal change in amplification and  No amplification or poor amplification. See causes and  
melt curves comments for “Flat amplification curves in the amplification  
 curves window” above.

  Incorrect dye was selected. Verify the appropriate dye was 
selected.

  The scale of the Y axis of the amplification curve was affected by 
other reactions on the plate. A high fluorescent signal for one or 
more reactions can cause the scale of the Y axis of the 
amplification curve to be too high to see changes in some data.
Adjust the scale of the Y axis to accommodate samples with 
smaller changes in fluorescence. See Section 8.G.

  The passive reference was set incorrectly. Be sure that the 
passive reference is defined correctly.

  Sample well(s) did not receive reaction mix. Examine the plate 
to identify any empty wells. Redefine plate map in HID or SDS 
software, omitting any empty wells. Reexport and reanalyze the 
data (Sections 4.E and 5.E).
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Symptoms Causes and Comments
Nonlinear standard curve, low R2 values <0.98 Be sure that the DNA standard was completely thawed and  
 mixed well before use. Store the DNA standard at 4°C  
 overnight to improve sampling consistency.

  Be sure dilutions of the DNA standard are well mixed before 
removing each aliquot for the serial dilution. Change pipette tips 
between each dilution step.

 Calibrate your pipettes to minimize variability when pipetting.

  Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; we recommend using a sample volume of 2µl or 
higher. If necessary, dilute the template so that larger volumes 
are pipetted.

  Adjust the baseline region. The baseline region can be manually 
adjusted for each reaction. See Section 8.D.

  Some variation is normal. Perform duplicate or triplicate 
reactions for each DNA standard to minimize the effect of this 
variation.

  There will be statistical variation in the amount of template in a 
reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for each DNA standard. 
Remove the 0.0032ng/µl dilution of the DNA standard from the 
standard curve by changing the sample type to “unknown”.

  An error was made during dilution of the DNA standard. Verify 
all calculations, and repeat dilution of the DNA standard. Do not 
pipet volumes <1µl.

  Incorrect concentration values were entered in the Plexor® 
Analysis Software. Verify the concentrations for all DNA 
standards used to generate the standard curve.

  Reactions were contaminated with target DNA. Clean 
workstations and pipettes with a mild bleach solution before and 
after use. Use new reagents and solutions. Take precautions to 
prevent contamination.

  The plate was not completely sealed. Carefully seal the plates to 
avoid evaporation.

  Aberrant fluorescence can be caused by writing on plates, 
contamination, fingerprints, etc. Do not write on the plate.  
Use caution when handling plates. Wear gloves. Do not place 
plates on surfaces that might be contaminated with fluorescent 
material. If you suspect contamination of the benchtop, thermal 
cycler block or any other area, clean it thoroughly.
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7. Troubleshooting (continued)

Symptoms Causes and Comments
Slope is outside of the range specified in  No amplification or poor amplification. See causes and  
Section 6.C comments for “Flat amplification curves in the amplification  
 curves window” symptoms above.

  Nonspecific amplification can become a problem in later 
amplification cycles for samples containing small amounts of 
target template. Decrease the number of amplification cycles.

  An error was made during dilution of the DNA standard. Verify 
all calculations, and repeat dilution of the DNA standard. Do not 
pipet volumes <1µl.

  There will be statistical variation in the amount of template in a 
reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for each DNA standard. 
Remove the 0.0032ng/µl dilution of the DNA standard from the 
standard curve by changing the sample type to “unknown”.

  Incorrect concentration values were entered in the Plexor® 
Analysis Software (Section 6.A). Verify the concentrations for all 
DNA standards used to generate the standard curve.

  There was variability or inaccuracy when pipetting reaction 
components. Calibrate pipettes to improve accuracy.

Instrument error appeared after selecting “Start”  When using the SDS software, version 1.4, with the Applied   
and before thermal cycling began, indicating  Biosystems 7500 FAST Real-Time PCR System, an error can  
a longer hold time is required for the detection  occur when the stages in Section 5.C are not deleted and  
step (often 36–37 seconds)  modified in the order described. This error can occur when 

Stage 1 of the default program is deleted rather than Stage 2. 
Close the current run, and program the instrument as described 
in Section 5.C.

  The instrument may not be functioning properly or consistently. 
Turn the instrument on and off, reboot the computer and restart 
the run.

Unable to import data. An error like “Expecting  The data were altered after export from the real-time PCR  
NEWLINE, found’’ or “Unexpected Token instrument software. Any alteration of this data is likely to  
Error” was encountered change the formatting and can cause import errors. Do not  
 open the exported files with other software programs.

Data display appeared abnormal in the Plexor®  Be sure that the display settings for the computer were set to  
Analysis Software (the screen appeared  32-bit color, rather than 16-bit color, when using the Plexor®  
compressed, lines were replaced with dots, etc.) Analysis Software.
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8. Appendix

8.A. Plexor® Analysis Software Operating System Compatibility

The Plexor® Analysis Software is fully compatible with Windows® 7. The Plexor® Analysis Software is not compatible 
with Macintosh® operating systems.

Be sure that the display settings for the computer are set to 32-bit color, rather than 16-bit color, when using the 
Plexor® Analysis Software.

8.B. Quantification Using Large Sample Volumes

You may wish to increase input volumes to increase sensitivity or match the input volume of subsequent STR assays. 
In-house validation is required for any protocol modifications. The Plexor® HY System allows up to 9µl of input 
material per reaction. The sample volume can be increased as long as the final reaction volume remains constant.  
The reaction volumes must be the same for both the DNA standards and unknown samples. This allows  
the DNA standards to be considered as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume).

Table 9 shows the necessary serial dilutions to perform an alternative standard curve using 5µl input volumes and  
DNA standard concentrations in the range of 1.28pg/µl to 20ng/µl.

Table 9. Serial Dilution of the Plexor® HY Genomic DNA Standard for the Alternative Standard Curve 
(assumes 5µl of DNA per reaction).

Concentration Volume of DNA Volume of TE–4 Buffer

20ng/µl Use 10µl of DNA 15µl

4ng/µl 10µl of 20ng/µl dilution 40µl

0.8ng/µl 10µl of 4ng/µl dilution 40µl

0.16ng/µl 10µl of 0.8ng/µl dilution 40µl

0.032ng/µl 10µl of 0.16ng/µl dilution 40µl

0.0064ng/µl 10µl of 0.032ng/µl dilution 40µl

0.00128ng/µl 10µl of 0.0064ng/µl dilution 40µl
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8.B. Quantification Using Large Sample Volumes (continued)

Reaction Setup

Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY Master Mix and Plexor® HY 
Primer/IPC Mix as indicated in Table 10.

Table 10. Preparation of Reaction Mix for Quantification Assays (5µl of template per reaction).

Component Volume (Per Reaction)

Plexor® HY 2X Master Mix 10µl

Water, Amplification Grade 4µl

Plexor® HY 20X Primer/IPC Mix 1µl

Final volume 15µl

If the sample volume is increased, decrease the volume of water added to each reaction so that the final reaction volume 
is constant.

Proceed with reaction setup as described in Sections 4.B and 5.B, but dispense 15µl of reaction mix to wells, rather 
than 18µl. Add 5µl of sample DNA or DNA standard to each reaction. Add 5µl of TE–4 buffer to the NTC reactions.

Data Analysis

During sample definition (Section 6.A), the dilution series must be modified to reflect the change in concentration of 
the DNA standards. When using 5µl input volumes, note that the dilution series is a decreasing, fivefold dilution series 
with “20” as a starting concentration or an increasing fivefold dilution series starting with “0.00128”, as appropriate 
for the plate layout used.

8.C. Special Considerations for Importing Comma-Delimited Data Files

The Applied Biosystems 7500 and 7500 FAST Real Time PCR Systems using SDS Version 1.4 or prior export data in a 
comma-delimited (.csv) file format. In some regions of the world where commas are used in place of decimal points, 
computers are set so that a *.csv file is delimited by semicolons or an alternative symbol. The Run Importer software 
requires comma-delimited files. If .csv files are not comma-delimited or the Run Importer software rejects the .csv files, 
convert the exported file to a comma-delimited file before importing.
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8.D. Adjusting the Baseline Region (Optional)

The Plexor® Analysis Software automatically sets the baseline region for each sample during import. The baseline is set 
in a flat region of the amplification curve before product accumulation (i.e., the downward inflection). Manual 
adjustment of the baseline region is possible for each sample but rarely necessary. Manual adjustment might be 
required for runs where the baseline region is set during or after amplification (i.e., not within the flat part of the 
amplification curve; Figures 48 and 49).
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Figure 48. An amplification window showing an improper baseline region with an improper baseline 
upper limit.
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Figure 49. An amplification window showing an improper baseline region with improper upper and 
lower limits.

In some instances, manual adjustment may provide optimal representation of the data. This may include samples with 
excessive noise, bleedthrough or early Cq values or situations where the real-time instrument shows early signal 
fluctuation. Figures 48 and 49 show examples of data with improperly set baseline regions that should be adjusted 
manually. In Figure 48, the upper limit of the baseline region (21.1) is within the visible signal change. The Cq value 
was erroneously increased to accommodate this baseline region. In general, the upper bound of the baseline region is 
set several cycles before the amplification curve crosses the threshold. In this example, the difference between the 
upper baseline region bound and Cq value is only 0.7 cycles. In Figure 49 the lower and upper limits of the baseline 
region (32.0 and 35.0, respectively) are set after the visible signal change. The baseline region must precede the visible 
amplification. A properly set baseline region with appropriate lower and upper limits is shown in Figure 50.
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Figure 50. An amplification window showing the proper baseline region and baseline upper and lower 
limits.
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8.D. Adjusting the Baseline Region (Optional; continued)

1. Select the PCR Curves tab.

2. Select the Display and Manually Adjust Baselines icon: 
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3. Select the samples to be adjusted using the well selector.

 Note: The baseline region can be adjusted for individual samples or groups of samples by selecting or dragging 
the lower and upper limits. The shading in the baseline region will be gray if the selected samples do not share a 
common baseline region (Figure 50). The baseline is set independently for each dye.

4. Adjust the upper limit of the baseline region for each sample so that the upper limit is approximately 5 cycles 
before the decrease in fluorescence and in an area where the baseline is flat. The Cq values for selected samples 
are displayed in the table to the right of the graph. The Cq value may change when the limits are changed.

Notes:

1. A maximum upper limit of 35 cycles can be used for samples without a Cq value (e.g., no-template control).

2. Samples with similar Cq values can be adjusted simultaneously by highlighting multiple wells.

5. If necessary, adjust the lower limit to a region that creates the flattest baseline given the selected upper limit.

6. Optional: The amplification threshold is based on noise within the baseline region for all samples. When 
manual baseline adjustments are complete, consider recalculating the amplification threshold for all samples. 
Select all samples, and in the Edit menu, select “Set Amp Threshold from Selected Samples” (Section 8.E).

Notes:

1. To reset the baselines for a selected set of samples, select the samples in the well selector, and in the  
Edit menu, select “Set Baselines for Selected Samples”.

2. The baselines for all samples can be reset to the automatic setting by selecting the Reset Baselines and  
Amp Thresholds icon: 
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8.E. Adjusting the Amplification Threshold (Optional)

The amplification threshold is used to determine the Cq value for the samples (Figure 51). The default amplification 
threshold is based on the variation (noise) in the baseline regions of all samples. It is determined by calculating the 
mean and standard deviation of all RFU values in the baseline regions and setting the threshold to 10 standard 
deviations below the mean.

Optional: The amplification threshold may be reset to change the sensitivity in detecting the amplification product.

1. To adjust the amplification threshold based on a selected set of samples, highlight the desired samples in the well 
selector. In the Edit menu, select “Set Amp Threshold From Selected Samples”. Enter the number of standard 
deviations of the background within the baseline region to use. The default is 10 standard deviations.
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Figure 51. The amplification threshold.

2. To manually adjust the threshold, place the cursor over the threshold, and drag the line to the desired location. 
Alternatively, double-click on the threshold, and enter the desired value.

!  Changes made to the amplification threshold will apply to the entire data set within the same dye channel, 
including those samples that were not selected.

3. Optional: The amplification threshold is based on noise within the baseline region for all samples. When 
manual baseline adjustments are complete, consider recalculating the amplification threshold for all samples.

Notes:

1. The amplification threshold can be reset based on all samples. Select all samples, and in the Edit menu, 
select “Set Amp Threshold from Selected Samples”.

2. The amplification threshold and baselines for all samples can be reset to the automatic setting by selecting 
the Reset Baselines and Amp Thresholds icon: 
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8.F. Adjusting the Melt Threshold (Optional)

Optional: The melt threshold may be reset to change the sensitivity in detecting the amplification product. See  
Notes 1–4. The default melt threshold is set at 25% of the signal change for the sample within the set that has the 
greatest change in signal. In some instances, the sample(s) used to set this threshold may not be typical of the data set.

To adjust the melt threshold line based on a selected set of samples, highlight the desired samples in the well selector. 
In the Edit menu, select “Set Melt Threshold From Selected Samples”. Enter the desired percentage of signal change.

To manually adjust the melt threshold line, place the cursor over the threshold line, and drag the line to the desired 
location. Alternatively, double-click on the threshold line, and enter the desired threshold value.

Notes:

1. The melt threshold is the level of signal that must be reached for the Plexor® Analysis Software to “call” the melt 
results. Target Tm indicators are included in the table to the right of the amplification and melt curve windows.

2. A “Yes” or “No” in the Tm? column indicates whether a sample Tm is within the expected target melt temperature 
range. A “No Call” in this column indicates that the melt curve displays the correct expected target melt 
temperature but there is insufficient amplification product to cause the amplification curve to cross the melt 
threshold.

3. The “Tm#” is the number of peaks that cross the melt threshold line. More than one peak indicates 
heterogeneous amplification products or improper calibration. This may be due to nonspecific amplification.

4. Changes made to the melt threshold line will apply to the entire data set within the same dye channel, including 
those samples that were not selected.

8.G. Adjusting the Y Axes of the Amplification and Thermal Melt Curves (Optional)

The scales of the Y axes for the amplification curve and melt curve in an experiment are determined by the sample that 
yields the most amplification product (i.e., the sample with the greatest decrease in signal). These scales are set for the 
entire data set.

If you toggle the “Rescale Graphs From Selected Wells” command (from the Window pull-down menu), the scale of the 
Y axes will be adjusted automatically based only on the wells currently selected for viewing.

The scale of the Y axis can be set manually by double-clicking on the Y axis of the graph and entering the new value in 
the pop-up window. This change will alter the scale for the entire data set.

8.H. Templates for Routine Setups Using a Master Template (Optional)

You may define templates for creating a Master Template to import all the other templates for routine analysis. The 
Master Template option is available only with Plexor® Analysis Software, version 1.6.0 or higher. Use the Master 
Template when the same instrument and software version, plate layout and analysis parameters are routinely used in 
the laboratory.
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A Master Template will contain all the other templates you can create for routine analysis (e.g., assay template, run 
template, analysis template, forensic template). Creating a Master Template will allow you to import and analyze data 
using the Plexor® Analysis Software in one step. The Master Template option is available only with Plexor® Analysis 
Software, version 1.6.0 or higher. Use the Master Template when the same instrument and software version, plate 
layout and analysis parameters are routinely used in the laboratory.

Creating a Master Template

To create a master template, the “Assay Template”, “Run Template”, “Analysis Template” and “Forensic Template” 
must be created and saved first.

Note: The figures in this section were generated using HID software data files. The specific instrument and software 
version must be selected in the Plexor® Analysis Software during import.

1. In the Plexor® Analysis Software, make sure the “Use Master Template On Import” option in the File menu is 
unchecked.

2. Import the new run following the instructions provided in Section 4.E or 5.E.

3. Choose instrument, targets, dyes and data collection stages (Step 1). See Figure 52.

4. Select "Export" to save the assay template as “Chosen Assay Template.atp”.
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Figure 52. The Assay Setup screen.
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8.H. Templates for Routine Setups Using a Master Template (Optional; continued)

5. Optional: Enter operator name and other details (Step 2).

6. Import data file (Step 3). See Figure 53.

7. Select "Finish".
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Figure 53. The File Import screen.

8. Define DNA standards, samples and analysis parameters as described in Section 6.

9. Analyze the data with the Plexor® Analysis Software as described in Section 6.
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10. In the File menu select "Export Run Template” to save the run template as Chosen Run template.rtp  
(Figure 54).

11. In the File menu select “Export Analysis Template” to save the analysis template as Chosen Analysis template.ntp 
(Figure 54).
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Figure 54. The Plexor® Analysis Software File menu. Check “Export Run Template (.rtp)” and “Export Analysis 
Template (.ntp)”.
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8.H. Templates for Routine Setups Using a Master Template (Optional; continued)

12. In the Forensic menu, select Forensics and Set Normalization and IPC Parameters (Figure 55); edit as necessary. 
Select “Export”, and save as Chosen Forensic template.ftp.
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Figure 55. The Set STR Normalization and IPC Parameters screen. Select “Export” and save as Chosen 
Forensic template.ftp.
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13. Make sure the “Use Master Template on Import” option in the File menu is checked (Figure 56).
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Figure 56. The Plexor® Analysis Software File menu. Check “Use Master Template On Import”.

14. Exit the Plexor® Analysis Software when the templates are created and saved.
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8.H. Templates for Routine Setups Using a Master Template (Optional; continued)

15. Select "Import" in the File menu. The Master Template screen will open (Figure 57). In the Assay Setup section 
of the Master Template screen, browse to and choose the saved Assay Template file (.atp).

16. Under "Advanced Options" at the bottom of the Master Template screen, browse to and select all saved chosen 
templates (.rtp, .ntp, .ftp) in the appropriate field as shown in Figure 57.

17. Select “Export” and save the newly created template (.mtp).

18. In the “Import” section of the Master Template screen, browse to the data file and import the file.

19. Add run information, such as experiment name or operator name, if necessary.

20. Select “Finish”.
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Figure 57. The Master Template screen.

Using a Master Template

1. Make sure the “Use Master Template on Import” option in the File menu is checked

2. Select “Import”, and choose the Master template.mtp file saved in Step 17.

3. In the “Import” section of the Master Template screen, browse to the data file and import the file.

4. Add run information if necessary.

5. Select “Finish”.
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8.I. Templates for Routine Setups Without Using a Master Template

If you do not wish to use the master template, you may define two templates that can be used to apply standard plate 
configuration and assay parameter information to routine experiments: “Run Template” and “Analysis Template”, 
respectively. You can define and apply these templates during the run data import process (at Step 3 – File Import;  
see Figure 20 in Section 4.E); you also can specify that templates be applied automatically during import.

Templates also can be produced (exported) or applied (imported) from the Analysis Desktop using commands from the 
“File” pull-down menu.

Run Template: A Run Template is used to assign sample types, sample colors and concentrations of DNA standards 
(Figure 58). If you routinely use the same setup for plates of standards and unknowns, a Run Template can be created, 
stored and applied to subsequent runs.

1. To define or modify a template during run data import, in Step 3 – File Import, in the “Advanced Options” 
section, click the “Edit” button under “Run Template”.

2. Assign colors, sample types and DNA concentrations to the standards in the Plate Setup tab.

 Note: To import an existing *.rtp file that contains a saved plate configuration, select “Import” and browse to 
that file.
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Figure 58. A run template.
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8.I. Templates for Routine Setups Without Using a Master Template (continued)

3. Use the Sample Names tab to label your samples. Simply select the sample you wish to name and start typing.

4. Select “Export” to save the plate configuration to a *.rtp file for later use.

5. If you wish to have the current template automatically applied to future datasets during import, click on 
“Defaults...” at the top of the window and then select “Save as Default”. The Run Template specified as the 
default will then be named in the “Advanced Options” section of the “Step 3 – File Import” window.

6. Select “OK”. Template parameters will be loaded and can be edited if desired.

Run Templates also can be produced or applied post-import. To save a Run Template based on the plate parameters 
defined in the assay currently displayed on the Analysis Desktop, click on the “File” pull-down menu, and select 
“Export Run Template (.rtp)”. To apply a saved Run Template to the assay currently displayed on the Analysis Desktop, 
click on the “File” pull-down menu, and select “Apply Run Template (.rtp)”.

Analysis Template and Definition of Analysis Functions: The Analysis Template is used to optimize the analysis 
settings for the experiment. A template can be set up to include the expected target melt temperature for each reaction. 
The expected target melt temperature should be determined for each real-time instrument. We recommend the default 
settings for all other analysis parameters.

1. To define or modify a template during run data import, in Step 3 – File Import, in the “Advanced Options” 
section, click the “Edit” button under “Analysis Template”.

2. Enter the desired values for the “Expected Target Melt Temperature (Tm)” for each dye used (Figure 59).

Notes:

1. Descriptions of the analysis details are provided below.

2. To import an existing *.ntp file that contains the saved default settings, select “Import” and browse to that 
file (Section 5.E, Step 11).

3. Select “Export” to save the Analysis Template as  a *.ntp file for later use.

4. If you wish to have the current template automatically applied to future datasets during import, click on 
“Defaults...” at the top of the window and then select “Save as Default”. The Analysis Template specified as the 
default will then be named in the “Advanced Options” section of the “Step 3 – File Import” window.

5. Select “OK”.

Analysis Templates also can be produced or applied post-import. To save an Analysis Template based on the parameters 
defined in the assay currently displayed on the Analysis Desktop, select “Export Analysis Template (.atp)” from the  
File menu. To apply a saved Analysis Template to the assay currently displayed on the Analysis Desktop, select “Apply 
Analysis Template (.atp)” from the File menu.
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Figure 59. The Analysis Defaults tab.

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations: The Plexor® Analysis Software 
has a user-definable amplification threshold that determines the RFU value at which sample Cq values are called. This 
threshold value is based on the variation (noise) in the baseline regions of all samples and is determined by calculating 
the mean and standard deviation of all RFUs in baseline regions. The threshold is set at a specified number of standard 
deviations below the mean. The default threshold is 10 standard deviations but can be changed in the analysis template 
or recalculated at any time by using the Set Amp Threshold from Selected Samples option in the Edit menu (Section 8.E).

Default Melt Threshold –d(RFU)/dT Percentage: The melt curve allows you to distinguish amplification products 
with different sequences and lengths. In the absence of nonspecific amplification products, the melt curve will have one 
peak. Each sample has a melt curve, from which a Tm can be determined. A Tm value is reported for all melt curves that 
cross the melt threshold and are present within the expected melt temperature range. The melt threshold represents the 
–d(RFU)/dT value that is required before a Tm value is reported for a sample. A sample’s Tm value is calculated as the 
temperature at which the melt curve has the lowest (i.e., the most negative) –d(RFU)/dT value.

The default melt threshold –d(RFU)/dT percentage is preset at 25.0% and can be set between 0.0 and 100.0%. This 
value is used by the software to calculate the melt threshold value. The Tm threshold value is defined as a percent of the 
–d(RFU)/dT value for the sample with the lowest –d(RFU)/dT value in the data set.

See Section 8.F for instructions to adjust the melt threshold.
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8.I. Templates for Routine Setups Without Using a Master Template (continued)

Expected Target Melt Temperature: The expected target melt temperature is the melt temperature of the correct 
PCR product (Section 6.B). The default expected target melt temperature is 90°C.

Target Tm Upper Bound: The target Tm upper bound is the number of degrees Celsius above the expected target melt 
temperature at which a sample Tm is considered to be suspect. The default target Tm upper bound is +1.5°C.

Target Tm Lower Bound: The target Tm lower bound is the number of degrees Celsius below the expected target melt 
temperature at which a sample Tm is considered to be suspect. The default target Tm lower bound is –1.5°C.

8.J. Spectral Calibration Results

A. FL B. CO560

C. CR610 D. IC5
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Figure 60. Example dye calibration results for Plexor® HY System. See Sections 4 and 5 for instrument 
calibration instructions.
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8.K. Icon Definitions

 Assign Color (shortcut = “q”)

The Assign Color function allows you to select a color in which a sample is displayed. This color selection is associated 
with those samples in the amplification and melt curves, well selector and any reports. Select one or more wells using 
the well selector, then select this button to choose the desired color for the selected samples. Sample color does not 
change the analysis of a sample in any way.

 Assign Unknown (shortcut = “w”)

The Assign Unknown function allows you to assign the sample type “Unknown” to all selected samples. Select one or 
more wells using the well selector, then select this button to assign the sample type “Unknown”. Unknown samples are 
displayed as open squares in the well selector. They are labeled “Unknown” in reports. When included in a standard 
curve, the concentrations of unknown samples will be calculated and reported if a Cq value is present.

 Assign NTC (shortcut = “e”)

The Assign NTC function allows you to assign the sample type “No Template Control” to all selected samples. Select 
one or more wells using the well selector, then select this button to assign the sample type “No Template Control”. 
No-template control reactions are displayed as diamonds in the well selector. They are labeled as “No Template 
Control” in reports. When included in a standard curve, the concentration of sample in the no-template control 
reaction will be calculated and reported if a Cq value is present.

 Assign Positive Control (shortcut = “t”)

The Assign Positive Control function allows you to assign the sample type “Positive Control” to all selected samples. 
Select one or more wells using the well selector, then select this button to assign the sample type “Positive Control”. 
Positive control samples are displayed as hexagons in the well selector. They are labeled “Positive Control” in reports. 
When included in a standard curve, the concentrations of positive control samples will be calculated and reported if a 
Cq value is present.

 Assign Standard (shortcut = “r”)

The Assign Standard function allows you to assign the sample type “Standard” to all selected samples. Select one or 
more wells using the well selector, then select this button to assign the sample type “Standard”. Only samples that have 
been assigned a type of “Standard” will be used to generate the best-fit line in standard curves. All DNA standards must 
be assigned a concentration by the user when they are defined as a standard. Concentrations may be entered in 
standard format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). See 
Section 6.A. The software does not accept commas in the concentration assignments. Standards are displayed as circles 
in the well selector and standard curve graphs. They are labeled “Standard” in reports.
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8.K. Icon Definitions (continued)

 Create Dilution Series (shortcut = “f”)

The Create Dilution Series function creates a full dilution series within a row or column of wells. Select the wells that 
contain a dilution series of the DNA standard, then select “Create Dilution Series”. You must enter the initial 
DNA concentration of the series, the dilution factor and whether the series is increasing or decreasing (Figure 36). 
Concentrations may be entered in standard format (0.01, 0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 
1e0, 1e1, 1e2, 1e3, etc.). The software does not accept commas in the concentration assignments.

All selected wells will be assigned the sample type “Standard” with a corresponding concentration. This function can 
only be performed with DNA standards in adjacent rows or columns. Using this function produces the same result as 
selecting each well in the series individually and assigning it the sample type “Standard” with the appropriate 
concentration. Only samples that have been assigned the sample type “Standard” will be used to generate the standard 
curves.

 Add Standard Curve (shortcut = “d”)

The Add Standard Curve function fits the experimentally measured Cq values and user-entered concentration values for 
DNA standards to a straight line using the least mean squares method. It will calculate the DNA concentrations of 
unknown samples, positive control reactions and no-template control reactions from their measured Cq values using the 
equation for the best-fit line. Any sample with a concentration of “N/A” on the report or elsewhere did not cross the 
amplification threshold, so the concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standards, as well as all other samples for which you wish to calculate 
concentrations. Choose “Add Standard Curve” from the Edit menu, and type “d” or select the Add Standard Curve icon 
on the toolbar.

You may create as many standard curves as you wish for a single set of data, but no sample can be used to generate 
more than one standard curve. It is not possible to add samples to an existing standard curve, but a new curve can 
easily be constructed with a new selection. This action will remove the existing standard curve and generate the new 
standard curve using the samples you have selected. You may generate the original standard curve at any time.

 Remove Standard Curve (shortcut = “c”)

The Remove Standard Curve function removes the standard curve on the tab that is currently selected. This function is 
only available in the Standard Curves tab.
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The Display and Manually Adjust Baselines function allows you to set the baseline range for a sample or set of samples. 
Select one or more wells using the well selector, then select this button. See Section 8.D.
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 Reset Baselines and Amp Thresholds

The Reset Baselines and Amp Thresholds function allows you to reset the baseline range and amplification threshold 
for all samples. See Sections 8.D and 8.E.



Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · 608-274-4330 · Fax 608-277-2516 77
www.promega.com  TM293 · Revised 9/17

8.L. References

1. Sherrill, C.B. et al. (2004) Nucleic acid analysis using an expanded genetic alphabet to quench fluorescence.  
J. Am. Chem. Soc. 126, 4550–6.

2. Johnson, S.C. et al. (2004) A third base pair for the polymerase chain reaction: Inserting isoC and isoG.  
Nucleic. Acids Res. 32, 1937–41.

3. Moser, M.J. and Prudent, J.R. (2003) Enzymatic repair of an expanded genetic information system. Nucleic. 
Acids Res. 31, 5048–53.

8.M. Composition of Buffers and Solutions

TE–4 buffer (10mM Tris-HCl, 0.1mM EDTA [pH 8.0])

 1.21g Tris base

 0.037g EDTA (Na2EDTA • 2H2O)

Dissolve Tris base and EDTA in 900ml of deionized water. Adjust to pH 8.0 with HCl. Bring the volume to 1 liter with 
deionized water.

8.N. Related Products

Product Size Cat.#
PowerQuant™ System 200 reactions PQ5002

 800 reactions PQ5008

PowerPlex® Fusion 6C System 50 (or 100 direct-amp) reactions DC2705

 200 (or 400 direct-amp) reactions DC2720

PowerPlex® Fusion System 200 reactions DC2402

 800 reactions DC2408

PowerPlex® Y23 System 50 reactions DC2305

 200 reactions DC2320

PowerPlex® 21 System 200 reactions DC8902

 4 × 200 reactions DC8942

PowerPlex® 18D System 200 reactions DC1802

 800 reactions DC1808
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8.N. Related Products (continued)

Product Size Cat.#
PowerPlex® ESX 17 Fast System 100 reactions DC1711

 400 reactions DC1710

PowerPlex® ESI 17 Fast System 100 reactions DC1721

 400 reactions DC1720

PowerPlex® 16 HS System 100 reactions DC2101

 400 reactions DC2100

Water, Amplification Grade 5 × 1,250µl DW0991

Not For Medical Diagnostic Use.

Sample Preparation Systems

Product Size Cat.#
DNA IQ™ System* 100 reactions DC6701

 400 reactions DC6700

Maxwell® 16 Instrument* 1 each AS2000

SwabSolution™ Kit** 100 preps DC8271

5X AmpSolution™ Reagent** 100 preps DM1231

DNA IQ™ Reference Sample Kit for Maxwell® 16* 48 preps AS1040

DNA IQ™ Casework Pro Kit for Maxwell® 16** 48 preps AS1240

Slicprep™ 96 Device** 10 pack V1391

*For Research Use Only. Not for use in diagnostic procedures. 
**Not For Medical Diagnostic Use.

8.O. Summary of Change

The following change was made to the 9/17 revision of this document:

1. An error regarding DNA concentration in Section 6.E was corrected.
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Japanese Pat. No. 3673175, European Pat. No. 1088060 and other patents pending. 
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WI 53711, or EraGen Biosciences, Corporate Licensing, 918 Deming Way, Suite 201, Madison, WI 53717. Phone (608) 662-9000; Fax (608) 662-9003. 
(c)This product is sold under licensing arrangements with Stratagene. The purchase price of this product includes limited, nontransferable rights under 
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other medical procedures. Further licensing information may be obtained by contacting the USB Corporation, 26111 Miles Road, Cleveland, OH 44128. 
(e)CAL Fluor® technology is the subject of pending patents and is licensed and sold under agreement with Biosearch Technologies, Inc., for research and 
development and forensic and paternity testing. These products are sold for use by the end-user only and may not be resold, distributed or repackaged. 
(f)Use of this product for basic PCR is outside of any valid US or European patents assigned to Hoffman La-Roche or Applera. This product can be used for 
basic PCR in research, commercial or diagnostic applications without any license or royalty fees.
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All prices and specifications are subject to change without prior notice.
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